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Abstract


Law students spend hundreds of thousands of dollars each year on statute books or statutory supplements for their courses.  These statutory supplements, notorious for their weight and bulkiness, are compilations of subject-specific statutes and regulations, most of which are publicly available at no charge.  This article discusses the advantages of digital statute books, details how the authors created a digital statute book that was used in two securities regulation courses, and evaluates the result of that experiment.
I.  Introduction


It seems like an offer only an idiot would accept: pay $40, $50, or more for a bulky, non-searchable print version of information that is not copyrighted and is readily available for free on the Internet.  We concede it’s a horrible deal, but we hesitate to call those who accept it idiots, because this is precisely the deal that hundreds of thousands of law students accept from Thomson/West, Aspen, Foundation Press, Lexis-Nexis, and other legal publishers every semester.  
The product is known as the statutory supplement
—collections of subject-specific statutes and regulations that are required for dozens of law school courses, from civil procedure to business associations to environmental law to basic income taxation.  Thousands of law professors regularly require these books and most law students, albeit often grudgingly, buy them.

Statutory supplements are often cheaper than casebooks,
 but the difference is misleading because the constant change in statutes and regulations diminishes the resale market for the supplements.  And they are a big recurring expense for students.  A law student could easily spend $500 or more during three years of law school just on statutory supplements.
  It’s not an astronomical figure when compared to law school tuition, but it’s not pocket change, either.

Commercial casebook publishers add very little value to the freely available, non-copyrighted material in statutory supplements, and they have no real comparative advantage in producing them.  Even if one concedes that published casebooks are an essential part of legal education and that commercial legal publishers have an essential role in producing them,
  statute books are different.  With very little effort, law professors could produce most of the statutory supplements required for their courses for free, just as they produce course syllabi and other handouts.  And they could provide those materials in more convenient digital form, not in the bulky print format offered by the commercial casebook publishers.
No new technology is required.  No special expertise is needed.  No huge expenditures are necessary to make this happen.  We have done what we propose, and the amount of time and effort required was minimal.  We produced a digital Securities Regulation statutory supplement for Professor Bradford’s two classes in the spring of 2009, saving students $900—an average of $45 each.
  
Nine hundred dollars is not a huge amount, but that is the savings for two very small classes at a single law school.  If you multiply that over time for all the courses across the country that require statutory supplements, the possibilities are phenomenal. The Association of American Law Schools consists of 171 law schools.
  If only one professor at each of those schools offered this digital option to a single class of twenty students, the savings for a single semester would be over $150,000.
II. The Advantages of Digital Statute Books


Cost savings alone justify a move to open-source, digital statutory supplements, but digital materials also have several other advantages over traditional, printed statute books.  Some of these advantages are pedagogical; some of them relate solely to ease of use.

A. Cost Savings

Digital statute books are cheaper to produce.
  The editorial work is essentially the same for digital and print statute books.  Someone must convert the statutes and regulations from the form in which they are publicly available to book format.  But the cost to produce and deliver digital materials is much less.  No ink or paper is used.  No physical delivery is required.  No bookstore is needed.  Digital materials can be delivered to both faculty and students on demand over the Internet.  
B.  Physical Advantages: Portability and Durability

Digital books, whether casebooks or statute books, have a clear physical advantage over printed books.  Print statutory supplements are both heavy and bulky.  Law students are notorious for struggling with huge backpacks or wheeled suitcases to carry all the books they need for their classes.  The print securities statutory supplement Professor Bradford has used for his Securities Regulation course
 weighs 4.8 pounds; the corporate law supplement he assigns for his Business Associations course
 weighs 5.6 pounds.  That corporate law supplement has over 2,300 pages and is almost three inches thick.  Statutory supplements are “overstuffed with statutes, regulations, interpretations, and model codes that the class will never discuss,”
 undoubtedly to ensure that no law professor will reject the book because it’s missing something he or she covers in class.

Of course, students must carry a laptop computer to class to use digital books (at least until a suitable e-book reader is available), but they only need one laptop computer for all their digital materials, and most students already carry laptops to class.
 One laptop clearly weighs less and is less bulky than one laptop plus statute books.

Digital books are also easier for students to deal with once they get to the classroom.  The average law school classroom seat is not designed for multiple books plus a laptop.  My students often sit with laptops on the table space, casebooks and (sometimes) casebook supplements occupying the rest of the table, with statute books perched on their laps.  With digital statute books, students have one less item to juggle.

Digital statutes are also more durable than physical statute books.  Book spines break; pages fall out or accidentally get torn.  For the most part, the printed statute books published by legal education publishers hold up well.  But these are, after all, paperback books.  The spines of the statute books used by Professor Bradford have sometimes broken and pages have sometimes fallen out.  Professor Bradford is a high-intensity user of these books compared to many of his students, but students have reported similar problems.  

Digital books do not physically deteriorate.  They can be erased accidentally or lost when a computer drive crashes.  But those problems are easily remedied by backing up the file.  Print statute books are also lost on occasion, and it is very expensive, and possibly illegal under current copyright law, to back up print books.  
C.  Updating

Print statute books, like casebooks, “are out of date the moment they are printed,”
 and certainly by the time they get to students.   The time required to print and deliver these books makes that inevitable.  For example, the print statute book Professor Bradford assigned in his spring 2008 Securities Regulation course included changes through October 1, 2007,
 over three months before the class started.  The cutoff date for the other major securities statutory supplement was March 1, 2007, almost a year before Professor Bradford’s spring class began.
   Sometimes, it is not even possible to tell what the exact cutoff date is.

It is easier to keep digital statute books up to date.  Since no printing or physical distribution is required, they can be updated immediately before the class begins.  The digital securities statute book Professor Bradford used in class beginning on January 12, 2009, was current as of December 29, 2008.  Anytime the statutes or regulations change, a simple software update brings the supplement up to date.  
D.  Ease of Use/Pedagogical Advantages


Digital statute books also offer potential pedagogical advantages over printed books.  Because of the weight and bulk of printed statute books, students often don’t bring them to school on days the particular class doesn’t meet.  If they want to study in their spare time, they’re unable to refer to the statute.
  Even on days when the class does meet, students sometimes forget to load the appropriate statute book into their backpacks, forcing them to share with another student or simply to do without.  Digital statutes are available whenever and wherever the student has her laptop (or any other device that can read an electronic file).  And a student is much less likely to forget her laptop than she is to forget a particular book.

Digital statutes are also easier for students to work with.  The material from digital books can be cut and pasted directly into student notes and outlines.  Professors can paste digital statutory materials directly into PowerPoint slide shows and handouts.  Statutory materials in print books have to be retyped or scanned.  
It is also easier to find material in digital statutes.  Students can search for particular text or section numbers.  A hyperlinked table of contents can make it easier to move around in the materials.  Print statute books have no search or hyperlink function, and it is often difficult just to find the appropriate table of contents.
 
E. Readability

No discussion of electronic materials is complete without addressing the bogeyman of readability.  Black-and-white printed text is easier to read than a computer screen.
  Computer screens have not yet reached the point where one would want to read novels on them.
  
On the other hand, screens are improving and there are some interesting developments just around the corner.
  Moreover, this generation of law students is much more comfortable with computer screens than past generations.  With the omnipresence of cell phones, digital audio and video players, and laptop computers, many of today’s students read on computer screens all the time.  
Finally, and most importantly, a statute book is not a novel.  One does not read continuously through a statute book.  Students read most statutes and regulations in precisely the same jumpy, small-bits-of-text-at-a-time manner than web browsing involves.  In fact, what Cory Doctorow calls the “cognitive style” of computers
 may fit statutes and regulations better than a printed book—precisely because of the text search and navigation features available on a computer.
III. Creating a Digital Statute Book


To create a digital statute book, one must first find the desired materials in digital form, then collate them and put them in a format suitable for student use.  The first step was relatively easy for us; the materials we needed are publicly available in digital format and are not copyrighted.  Professors preparing digital statute books for other courses might find this more difficult.  The second step—deciding on a format, and reformatting the materials---was the harder one for us, but even that was not overly complicated or time-consuming.

A.  Source Materials

The various materials that might be included in a statutory supplement—federal and state statutes and regulations, uniform and model acts, restatements of the law and legal principles—vary in availability.  Some are freely and publicly available on-line in various digital formats; some are not available at all. 

Some of these materials are available to law students and law professors through Lexis or Westlaw, but we decided not to use these services.  We believe creating a statutory supplement for students is consistent with our law school’s contracts with Westlaw and Lexis, but we were worried that those contracts might limit the uncertain future direction of the project.  Therefore, we avoided Lexis and Westlaw entirely.
Some of the materials that might be included in a digital statute book are available on-line through the Legal Information Institute at Cornell University.
  The LII is a non-profit activity of the Cornell Law School, and its web site is one of the best, if not the best, starting point for on-line legal resources.  However, the LII is, for the most part, a secondary source; it obtains its materials from other on-line resources.
  We decided to go directly to the primary sources of the material, rather than to use LII itself.

1. Federal Statutes

The United States Code is available on-line in digital format.
  The on-line version of the Code is provided by the Office of the Law Revision Counsel of the U.S. House of Representatives, the same office that is responsible for the printed Code.
  The on-line version is based on the latest edition of the Code, but it includes updates listing any subsequent amendments not reflected in the text.
  Thus, to obtain a fully updated version of the federal statutes, a user must manually revise the material to incorporate any amendments that have not yet been incorporated into the Code itself.
2. Federal Regulations

The Code of Federal Regulations is also available on-line.  The Electronic Code of Federal Regulations, or e-CFR, has been developed and is maintained as a joint venture between two federal government agencies, the Government Printing Office and Office of the Federal Register in the National Archives and Records Administration.
  It is updated daily and is usually current within two business days.
  Amendments are incorporated into the e-CFR as they become effective, but the e-CFR also includes hyperlinks to amendments that are not yet effective.
  

The e-CFR is not currently recognized as an official edition of the Code of Federal Regulations, but the plan is to make it an official compilation as soon as “all remaining technical and performance issues are resolved.”
  According to its sponsors, the plan is to continue “to make . . . [the e-CFR] . . . available for free, in perpetuity.”

Unfortunately, the e-CFR is not currently available in .pdf format, and it is unclear if it ever will be.

3. State Statutes and Regulations
The availability of state statutes and regulations in digital form varies from state to state.
  The on-line version of state materials has official status in only a few states,
 and some of these on-line resources present issues of authenticity.
  Moreover, the on-line versions are not always complete.
  In some states, most administrative regulations are not available on-line.
  Obviously, the ease with which one may include state materials is going to vary depending on the particular materials needed and the particular state.  Washburn Law School maintains a web site, Washlaw, which allows one to easily search for the materials of a particular state.

4. Uniform and Model Acts and Other Copyrighted Materials

Many courses use model or uniform acts and commentary, such as the uniform acts adopted by the National Conference of Commissioners on Uniform State Law (NCCUSL), the model acts adopted by the American Bar Association, or the restatements and commentaries adopted by the American Law Institute.  
The American Bar Association publishes a number of model codes and model acts, including, for example, the Model Rules of Professional Conduct and the Model Business Corporation Act.  Some of these materials, such as the Model Rules of Professional Conduct, are available on-line.
  Others, such as the Model Business Corporation Act, are not.

All of the Uniform Acts adopted by NCCUSL are available on an archive maintained by the University of Pennsylvania Law School.
  The uniform acts are available in .pdf, ASCII text, or WordPerfect formats, but, unfortunately, they are not available as Word documents.

The American Law Institute publishes both restatements of the law and some additional materials, such as Principles of the Law and certain codifications such as the Model Penal Code and the Uniform Commercial Code.  These materials are not publicly available on-line.

For some courses, such materials are essential.  For instance, the ABA’s Model Business Corporation Act and NCCUSL’s Uniform Partnership Act and Uniform Limited Partnership Act are indispensable in a Business Associations course.

Unfortunately, these materials, unlike federal and state statutes and regulations, are copyrighted.
  A statute book containing any of these materials can be assembled only with the permission of the copyright holder,
 and those copyright holders vary in their willingness to accommodate a project such as this.  None of this material was needed for the particular digital supplement we created, but we contacted the copyright holders to see how willing they would be to license their materials.
We contacted the American Bar Association about including the Model Business Corporation Act in a set of digital corporate law materials.  The ABA staff member was pleasant and cooperative, but the ABA ultimately rejected our request.  The commercial publishers include ABA material in their print statute books, so the ABA clearly licenses to them, but the ABA was unwilling to license its materials (whether or not they were paid a licensing fee) for a digital supplement that would be provided free to students.
  
The American Law Institute was much more receptive than the ABA.  We asked them if we could include their Principles of Corporate Governance in a set of digital corporate law statutory materials.  The ALI was unwilling to allow us to use the Principles for free, but they were willing to allow the Principles to be included in a digital supplement for a flat, nominal annual fee.  Because of the ABA’s refusal, we did not pursue this any further.

We also contacted NCCUSL about the possibility of including several uniform acts—the Uniform Partnership Act, the Uniform Limited Partnership Act, and the Uniform Limited Liability Company Act—in a digital corporate law supplement.  NCCUSL was also more accommodating than the ABA, but we terminated the discussions when the ABA rejected our licensing request.
B.  Formatting

1. Criteria

The first step in creating a digital statutory supplement is to find the statutes and regulations in digital form.  The second step is deciding how to package those materials for student use.  A number of different formats are possible—.pdf files readable by Adobe Acrobat Reader; web-based .html format; proprietary word processing formats used by WordPerfect and Word; .txt text files.

Eight criteria guided our choice of format.  First and foremost, we wanted the format to be something students could access without having to purchase additional software.  Second, we wanted to create statutes and regulations that were easily navigable.  Third, we wanted students to be able to do text searches of the materials.  Fourth, we wanted students to be able to highlight and underline the materials.  Fifth, we wanted students to be able to add notes and comments.  Sixth, we wanted students to be able to copy text from the materials and paste it into other materials such as their notes and outlines.  Seventh, we wanted the materials to be free of any digital rights management (DRM) software that would limit student use.  Finally, we wanted the materials to either be free to students or available for a nominal sum.
a. Accessibility

The first and most important requirement was student accessibility.
  We wanted students to be able to access the statutory materials we produced using either software they already owned or that is available to them at no cost.  We would not be doing a favor to law students if we forced them to buy $500 worth of software to access a free statute book.  We also wanted to use software that is relatively easy without technical sophistication to use.  Those preferences limited us to materials that can be read using a web browser like Internet Explorer or Mozilla Firefox, the free Adobe Acrobat Reader, or Microsoft Word.

b. Navigability

Students need to be able to move around in the materials.  They need an index that will allow them to orient themselves, find a statute or regulation, and locate a particular section within that statute or regulation.  They need to be able to move back and forth from index to statute to regulations, and from section to section within a particular statute or regulation, with little effort.  If it takes thirty seconds or more to find a particular section, the materials are not suitable for classroom use.


Fortunately, both Adobe Acrobat and Microsoft Word enable one to create a multi-level, collapsible index that facilitates navigation.  Through the use of frames, a similar result is possible using .html.  The ease with which such an index can be created varies, but it is possible for all of the formats we considered.

c. Text Searching


One of the major advantages of digital media over printed text is the ability to search for particular text.  A search function is particularly advantageous in statutory supplements, where students might be looking for a rule with particular language or that deals with a particular subject.  Thus, text searching was an essential requirement.

Luckily, all of the possible formats offer full text-searching capability.  Both Internet Explorer and Mozilla Firefox tie into numerous search engines, such as Google.  Microsoft Word and Acrobat Reader have their own search capabilities.  All of those platforms provide the basic text search capability we wanted.
d. Highlighting and Underlining
Many students (and professors) like to highlight and underline and some of them like to do it in multiple colors.  We wanted to choose a format that would allow students to highlight and underline and save the material in its marked-up form.  
Microsoft Word allows this.  One can highlight in multiple colors underline text, or even change the color of text.  All those changes to the document may be saved.  
Although many people seem unaware of the possibility, one can do the same thing to .pdf documents using only the free Adobe Reader.  The only requirement is that the person creating the .pdf document enables these features.
  However, the Adobe Reader highlighting and underlining tools are not particularly elegant or easy to use, certainly not as good as the same features in Microsoft Word.
Browsers like Internet Explorer and Mozilla Firefox, used to read .html documents, are more problematic.  Neither Microsoft Internet Explorer nor Mozilla have highlighting or underlining features built into the basic software.  Free add-ons that do have these functions are available for download, but we were a little uncomfortable with requiring students to install these add-ons as a condition to using the digital statute.
e. Adding Notes and Comments


Both Microsoft Word and Adobe Acrobat Reader allow one to post notes and comments (in the case of Acrobat Reader, only if the person creating the document has enabled the commenting features).  Neither tool is particularly good, but they work, and documents may be saved with the comments.  As with highlighting, neither Internet Explorer nor Firefox contain a comment tool, but add-ons are available that add note and comment functions.

f. Copying and Pasting


All of the formats we considered—.html, .doc, and .pdf—allow students to cut text and paste it into other documents.  And it is relatively easy to past all of these formats into whatever type of word processor the student is using, although formatting issues sometimes arise when one is pasting .html material into a Word or WordPerfect document.  
g. Digital Rights Management
We do not like digital rights management (DRM).  For those of you who don’t download music and have never heard of the Digital Millennium Copyright Act,
 DRM software prevents users from copying digital materials or converting them to other formats, or limits the ability of users to do so.  Until recently, most commercial music was sold with digital rights protection; almost all commercial video is still protected by DRM.  

The limited digital statutory materials that legal publishers have produced so far have incorporated DRM—usually by forcing students to go to a dedicated web site or to use proprietary software to use the materials.
  For commercial publication, the need for such restrictions is obvious.  In the absence of DRM, a student could purchase one copy of a statute book and freely copy it for everyone, with no loss of usability to the many students who copy it.

DRM appears to be slowly disappearing in the music world.  Most commercial music was originally sold on-line with significant DRM restrictions, but, in the face of pressure from sellers like iTunes and Amazon, most popular music is now available in a DRM-free format.  Similarly, some books are being offered free in unrestricted digital form in the hope that this will lead to greater sales of the printed book.
  
We rejected DRM for several reasons.  First, we are philosophically opposed to it.  Second, we wanted to restrict student use of the materials as little as possible; we didn’t want to force the students to go to a protected web site to view the materials, to use special proprietary software, or to download add-ons that disable some of the functions of their existing software.  We wanted the materials to be as portable as possible (which eliminates the possibility of any web-based DRM control).  And, for pedagogical reasons, we wanted students free to use any of the material wherever they would find it helpful--cutting and pasting into their notes; printing all or part of it; sharing their annotations.  DRM would make that more difficult, if not impossible.  Finally, since we decided to offer the materials for free, copying simply was not a concern. 
h. Pricing

One of our goals was to save students money, so pricing was an important issue.  We wanted to be able to provide the statutory materials to students for free or, at worst, for a nominal charge.  Pricing might have become an issue if we had to license copyrighted material, but we included no copyrighted material in this digital statute book.  The only cost of these materials was our time and effort, and the amount of time and effort involved was surprisingly small.

IV. The Experiment: A Digital Securities Regulation Statutory Supplement

We decided to test the practicality of digital statute books by preparing one for use in Professor Bradford’s two securities law classes in the spring of 2009—Securities Regulation; and Securities Brokers, Mutual Funds, and Investment Advisers.
A.  The Two Classes

The Securities Regulation class focuses on the regulation of the distribution and trading of securities.  The primary focus of the class is on the Securities Act of 1933 and the Securities Exchange Act of 1934, with a small bit of attention to state "blue sky" laws.  The statutory and regulatory materials needed for that class include the Securities Act, the Securities Exchange Act, the regulations adopted by the Securities and Exchange Commission under both statutes, and certain Securities Act and Exchange Act forms.  Professor Bradford’s Securities Regulation class also deals briefly with the Uniform Securities Act, which is copyrighted.  But Professor Bradford’s discussion of the Uniform Act is minimal, and the few sections of the Uniform Act Professor Bradford does discuss are fully described or quoted in the casebook he uses.  Therefore, he decided he did not need the Uniform Act in the supplement.

In addition to the digital statutory supplement, students in the Securities Regulation class used a traditional casebook—Securities Regulation: Cases and Materials, by James D. Cox, Robert W. Hillman, and Donald C. Langevoort.
  This book, published by Aspen Publishers, is a fairly traditional, problem-oriented casebook.  It includes cases, problems, regulatory releases, textual notes, and questions.

The Securities Brokers, Mutual Funds, and Investment Advisers class covers the regulation of investment professionals and entities by federal securities law: the regulation of brokers under the Securities Exchange Act; the regulation of investment companies under the Investment Company Act; and the regulation of investment advisers under the Investment Advisers Act.  For this class, students needed al the statutes and regulations used in the Securities Regulation class, plus the Investment Company Act, the Investment Advisers Act, and the SEC regulations and forms associated with those two statutes.

The Securities Brokers class is a little unique because students do not use a traditional casebook.  Instead, they use a combination of materials prepared by Professor Bradford and materials prepared by Professor Larry Barnett at Widener University entitled Readings on the Investment Company Act and the Investment Advisers Act.  We thought this class would be an especially good test of the future of digital statute books. The course materials themselves are distributed to students in digital (.doc) format and some of the students choose not to print them.  This was a good opportunity to see how a digital statute book interacts with a digital casebook, something that is more likely to occur in the future.


Our original intent was to create two separate statutory supplements, one for each course.  However, because of the overlap between the two courses and because we did not believe file size was a potential problem, we ultimately decided to prepare only a single supplement that contained all the statutes needed for both courses.

B.  Preparing the Materials

We obtained .txt file versions of the federal securities statutes from the on-line U.S. Code web site.
  We obtained the federal regulations from the e-CFR web site.
  We obtained copies of the SEC forms from the SEC’s own web site.

Unfortunately, we could not dump this material directly into Word documents
 without losing some of the formatting, so we had to reformat the materials to restore the proper alignment.  Fortunately, we were able to do this in a way that did not require line-by-line reformatting.
  We devised a method that took approximately two hours of time for each of the sets of regulations and approximately two to three hours of time for each statute.  Instructions for how to do this using Microsoft Word appear in Appendix A (the statutes) and Appendix B (the regulations).

This reformatting may seem like a lot of time and effort, but it is a one-time effort, at least as far as the statutes are concerned.  Once the materials are properly formatted, the only additional effort required from year to year is to track and incorporate amendments into the existing materials.  Originally, the plan was to update all the materials, statutes and regulations, in this manner, but we decided it would not be efficient to update the regulations in this way.  The regulations are amended much more often than the statutes
 and, we decided it would be easier to redo the regulations each year from scratch, rather than cutting and pasting so many changes.  The statutes change less often, so we will maintain those by cutting and pasting any changes; this will also make it easier to add functionality to the statutes over time, including internal hyperlinks.
To simplify the process, we saved each regulation or statute as a separate Word file, and combined them only when we created the final product.  We were also very careful to back up the reformatted materials, so we do not have to redo the formatting.  We prepared a separate title page for the digital statute book that includes a brief explanation of how to use the materials.  Once we had all the Word files prepared, we easily converted them into .pdf files using the Acrobat add-on in Word 2007.  We then merged the individual .pdf files into the digital statute book using the “Combine” function in Adobe Acrobat.

The Acrobat add-on in Word allows one to automatically tag headings, subheadings, and other materials, and Adobe Acrobat can use those tags to generate bookmarks.  It took some experimentation to determine exactly what in the Word files needed to be tagged for bookmarking, but once we had things properly tagged, Adobe Acrobat created the bookmarks without a problem.  All we had to do after that was create a couple of additional bookmarks by hand and expand the bookmarks into a multi-tier, collapsible index.

Here is an example of what our index looks like.  The first screen shot is of the index fully collapsed:

The second screen shot shows one of the collapsible indices expanded:

[image: image1.png]TTITLE PAGE
Securities Act 12-29-08
EF] SECURITIES ACT REGULATIONS

] Rule 100 Definitions of terms used in the rules and
regulations.

Rule 110 Business hours of the Commission.

Rule 111 Payment of fees.
Rule 120 Inspection of registration statements.
Rule 122 Non-disclosure of information obtained in
the course of examinations and investigations.

Rule 130 Definition of “rules and regulations” as used
in certain sections of the Act.

Rule 131 Definition of security issued under
‘governmental obligations.

Rule 132 _Definition of “common trust fund” as used
in section 3(a)(2) of the Act

Rule 133 Definition for purposes of section 5 of the
Act, of “sale”, “offer”, "offer to sell’, and "offer for
sale”.

BrrERRERRER EERRR

Rule 134 Communications not deemed a prospectus.
Rule 1342 Options material not deemed a
prospectus.

Rule 134b Statements of additional information.
Rule 135 Notice of proposed registered offerings.
Rule 1352 Generic advertising.

Rule 1350 Materials not deemed an offer to sell or
offer to buy nor a prospectus.

rERERER BE





Rather than try to fully describe the digital statute book in this article, we invite you to review it directly.  It is available on Professor Bradford’s web site.
  Anyone may download and copy the digital statute book, subject to a Creative Commons Attribution-Noncommercial-Share Alike license.  
C.  Using the Materials for the Classes

Students enrolling in the two courses were told that the statutory material was required for the class and were provided with the URL for the digital materials.  We also offered to put the statutes on a CD or USB drive for any students worried about download speeds, and had several CDs prepared, but no students asked for them.  To accommodate students who might not want to use the digital materials, Professor Bradford suggested a print alternative; the print statutory supplement was available in the University bookstore.
  Only four students chose to use the print book, and all of them also used the digital book at least part of the time.

Some readers might object that the choice between free digital materials and rather costly printed materials is an unfair one.  Some students might have chosen the digital materials for cost reasons even though they would have preferred to use the printed materials.
  That objection misses the point; cost affects the choices people make and to talk about preferences independent of cost is silly. The important question is whether the less costly alternative performs adequately.

Professor Bradford prepared for and taught both classes using only the digital statute book.  A professor could allow her students to use the digital statute book without using it herself.  A professor’s choice need not mirror the students’ choices.  But we also wanted to test the teaching efficacy of the digital statute book, not just its utility to students.

D.  Use of the Materials at Other Schools


We did not publicize the materials outside the University of Nebraska College of Law.  The materials were posted on a public web site, so anyone who stumbled across them could download and use them, but we wanted to test them with a small number of students before making them available nationally.  As far as we know, no students or faculty at other schools used the materials in the spring 2009 semester.  
V.  Overall Evaluation of the Experiment and Possible Future Changes

At the end of the semester, we surveyed the students in both classes to see if they used the digital statute book and, if they did, what they thought of the experience.  The survey form, with a full compilation of all student answers, is attached as Appendix C.  We circulated the survey near the end of the semester so students would have as much experience with the digital statute book as possible.  The response rate was extremely high; 24 of the 25 students enrolled in the two classes.

After the exam in each course, we sent an e-mail to the students asking them about their experience using the digital statutes on the exams.
  This e-mail and a compilation of the student responses are attached as Appendix D.

A.  The Student Experience
Twenty of the 24 students who responded to the survey used the digital statute book exclusively.   The other four students used both the digital statute book and the print statute book.  Two of those four used the digital statute book approximately 50 percent of the time and the other two used the digital statute book approximately 20 percent of the time.
  Three of the students who used both versions indicated they preferred to use a print book when they were working on another document on their computers, rather than using split screens or navigating back and forth.  Two of the students who also used the print book indicated that they simply preferred to read printed text.

The students’ overall response was very positive.  Seventeen of the students indicated they preferred the digital statute book to print books they had used in other classes and only three indicated they preferred print.
  Almost all of the students who chose to use the digital version indicated that they would choose it again if they had a choice.


One of the survey questions asked students what aspects of the digital statute book they found most appealing.  The leading responses fell into the following categories: the ability to navigate within the materials (11 responses); the ability to highlight and annotate (9 responses); price (7 responses); portability, as compared to a print book (7 responses); the ability to copy, cut, and paste (4 responses); and the ability to search (4 responses).
  
Another survey question asked students what they found least appealing about the digital statute book.  The negative responses were much more diverse, but the leading issue was navigation, particularly navigation within subsections of a statute.  Four students complained about some issue with navigation, and three of those students noted problems navigating within a section of the statute.
  The only other multiple responses were: problems with the computer running slow or freezing (2 responses); an inability to search (2 responses); and the inability to create additional bookmarks (2 responses).
  Some of those issues are discussed in greater detail in subsection C below.
B. Professor Bradford’s Experience

Professor Bradford used the digital statute book exclusively.  He used it to prepare for class, highlighting and annotating the copy on his laptop.  He cut and pasted from the digital statute book when he wanted to include statutory or regulatory language on PowerPoint slides.  And he used the digital statute book for reference as he taught.  He took the print copy to class each day as a backup,
 but neither Professor Bradford nor any of the students ever needed it.

Professor Bradford planned to show statutes and regulations directly from the digital statute book on the classroom projector.  He often projects statutes and regulations using PowerPoint slides because he believes this is an effective way to force students to grapple with the actual language of the rules.  However, the version of the digital statute book Professor Bradford kept open on his laptop during class included his own highlighting and annotations, and Professor Bradford wanted students to analyze the rules on their own.  Professor Bradford also had a clean version of the digital statute book on both his laptop and the classroom computer; he could have used that.  But it was easier just to incorporate the relevant statutory and regulatory language into PowerPoint slides, instead of switching back and forth from PowerPoint to the digital book.


Professor Bradford’s overall evaluation of the experiment was extremely positive, and he plans to continue using the digital statutes.  He had only two complaints; each was also reflected in student responses to the survey.  First, the highlighting and annotation features in Adobe Reader are a little cumbersome and, as a result, slightly slower than highlighting and annotating on a print copy.
  Second, like some of his students, Professor Bradford found it difficult to navigate within very long sections during class.  It was easier to find particular sections, but harder to find material within a lengthy section.
  Even when Professor Bradford found the relevant passage, he sometimes had to wait for his students to catch up.  
C.  Particular Issues

1.  Navigation


Student views on navigability were mixed.  Some students said it was harder to navigate in the digital statute book than in a print statute book.  Other students rated navigability as the best feature of the digital statute book, and indicated it was easier to navigate in the digital book.  Except for the one problem discussed in the next paragraph, we suspect this has less to do with the materials themselves than with students’ relative comfort browsing digital materials.


Several students indicated that it was easy to get lost within long sections of the statutes or regulations, a problem Professor Bradford also experienced on occasion.  Sections of the statute were bookmarked, so it was relatively easy to find one’s way to a particular section.  Subsections, however, were not bookmarked.  The hierarchical structure of the statute is indicated by progressive indentation, as show in the illustration below, but the level of indentation is not always obvious in a long passage.  Thus, it was sometimes difficult to determine exactly where one was in a lengthy section.
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A couple of students complained about their inability to add their own bookmarks.  We agree that personalized bookmarking would be a nice feature, but the Adobe Reader software does not allow it.  One can only add bookmarks to a document in the full-featured (and expensive) Adobe Acrobat software.  A JavaScript file that adds a bookmarking function to Adobe Reader is available on the Internet,
 but we are hesitant to suggest it to students, some of whom may not be technologically adept.
Unless students add the JavaScript file, the best alternative available in Adobe Reader is probably the Comment function.  Students can add comments to .pdf documents in Adobe Reader and one can view those comments in a separate navigation panel.  Students could simply add comments wherever they want their own bookmark and use the comments navigation panel to find them—but that panel would show all their comments, not just the ones they intended as bookmarks, and the comments would not be integrated into the section-by-section bookmarks.
2.  Highlighting and Annotation

Adobe Reader allows students to mark up their statutes in a number of ways.  Students can highlight, in a number of different colors.  Students can add text boxes, with or without arrows pointing to particular material.  Students can underline text, in various colors and different styles.  Students can put circles or boxes of various types around text.  Students can add comment boxes that pop up when clicked.  Students who are adept with their mouse or who have touch screens with pens can write in freehand on the statutes.    The screen capture below shows a number of different possibilities.
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Unfortunately, these Adobe Reader functions are somewhat cumbersome.  It is difficult to both underline and highlight the same text.  Highlighting in multiple colors involves a two-step process: first highlighting in the default color, then opening a Properties pop-up to change the color.  The same two-step process is required to change underlining colors or styles.

Given these difficulties, we were not surprised to see student complaints about the highlighting and annotation features.  Some students said they would have preferred highlighting and annotating a print book.  What surprised us were the positive comments; some students preferred to highlight and annotate the digital book in spite of these problems.  The latter group of students may just be more comfortable with computers and electronic materials generally.
3.  Speed of Use

Some of the students complained that their computers ran more slowly when using Adobe Acrobat to read the digital statute book.  Professor Bradford did not have any problems on his laptop computer, and he usually has a number of different programs and windows open.    However, Professor Bradford’s laptop is relatively new, with a relatively fast processor and ample RAM.  The digital statute book is approximately 18 megabytes, and the size increases with the addition of annotations and highlighting.
  Moreover, Adobe Reader is notoriously slower than many word processing programs.  It is understandable that students with older computers and slower processors might have problems.  

4.  Formatting Issues


The digital statute book had a couple of minor formatting problems, one of which was entirely our fault and will be corrected in later editions.   First, a few lines of text were missing at two points in one of the statutes.  The problem resulted from pure sloppiness—our failure to follow our own formatting instructions for that particular statute.  Professor Bradford “solved” the problem by distributing handouts containing the additional lines.


The second formatting problem was relatively minor: at a couple of points, the statutes did not indent properly.  Here is an example:
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This only happened a couple of times, and we are not exactly sure why.  It is at most an annoyance, but we will correct it manually in future versions of the digital statute book.
5.  Use on Exams


We were a little concerned about students’ ability to use the digital statute book to take the exams.  Professor Bradford requires students to take exams on their computers using Exam 4 software,
 and we were worried students might have trouble navigating between the exam and the statute book on a single computer monitor.  As far as I know, no one had any such trouble.  The post-exam comments were positive, and a couple of people even said they found it easier to use the digital statutes on the exam than to use printed statutes.

D.  Possible Future Changes


We plan a few changes to future editions of the digital statute book in response to student comments and Professor Bradford’s own experience using the book.  First and foremost, it is clear that some students need more instruction about how to effectively use the digital book.  Second, we want to make it easier to navigate within lengthy sections.  Third, we want to enhance the statutes by adding internal hyperlinks.

1. Additional Instruction in Using Adobe Reader

The first edition of the digital statute book includes some basic instruction in the use of Adobe Reader.
  In, particular we explain how to view the Bookmarks frame and how to highlight or add comments.  The survey responses make it clear that some students needed additional information about how to use Adobe Reader.

First, some students had trouble activating the highlighting and commenting features.  One student was using an older version of Adobe Reader that (the student said) did not include those features.
  A couple of students tried to used the.pdf reader Apple includes in its Mac software; that reader does not include the commenting features and apparently does not even enable the Bookmarks index.  Professor Bradford made it clear to students in the syllabus for each course that students would need Adobe Reader for the statutes; at least one of the Mac users just assumed the native .pdf reader on her Mac was Adobe Reader.  In the future, we will make it clear that students must download the latest version of Adobe Reader and use that to read the digital statute book.

Second, a couple of the survey comments indicate that some students were unfamiliar with Adobe Reader’s Find function, used to search within .pdf documents.  The survey comments indicate that other students found this function very helpful in navigating the digital statute book.  The Reader Find function is easy to use; it can be accessed either by typing Control-F or through the Edit menu.  The next version of the digital securities statutes will include specific instruction about using the Find function.

Third, the digital statute book’s instructions on highlighting and commenting are very brief.  We say:

2. Highlighting and Comments: You can highlight or add comments to these

materials. In the Adobe Reader Tools menu, choose Commenting, then click on

Show Commenting Toolbar. You can highlight, underline, or add notes or

comments to the text. Just remember to save the revisions when you exit the

materials.

In the future, we will expand this section to give students more instruction in how to highlight and underline in multiple colors, how to add comments and sticky notes, and how to add callouts.
  We may also hyperlink from the digital statute book directly to Adobe’s own discussion of these features.
2.  Bookmarking Subsections in the Statutes

Several students indicated that it was difficult to navigate within lengthy sections of the statutes.  We bookmarked only the sections of the statutes and rules themselves, and did not bookmark subsections.  Some of the sections, particularly definitions sections, go on for several screens, and it is easy to miss the subsection letters or numbers while scrolling through the material.  In the future, we will add an additional level of bookmarking in the statutes for subsections.

3.  Internal Hyperlinks in Statutes

Our goal this year was to produce a usable, bare-bones version of the materials, with enhancements to come later.  One of the enhancements that we intend to add is internal hyperlinks within the statutes.  If, for instance, the text of section 12 of the statute refers to section 5, a hyperlink would take the reader to section 5.  We also intend to include internal hyperlinks to defined terms.  Every time a defined word appears, a hyperlink would take students to the section defining that word.  We believe these enhancements will encourage students to explore the interrelationships within the statutes.
VI. As For the Legal Publishers, . . .
A.  The Commercial Casebook Publishers’ Problem

Our initial experiment with digital statute books was a success.  Students saved money and the digital materials performed at least as well, and in the opinion of many students, better than equivalent print supplements.  Professor Bradford intends to keep these materials updated and make them available to any student or professor who wants to use them.
Anyone could have done what we did.  We are both comfortable with computers and electronic materials, but we have no special expertise.  The time and effort involved, once we determined exactly what we wanted to do, were minimal.  Other professors could easily prepare similar digital supplements for other subjects, and we hope they will.
  With future advances in software and technology, creating materials like this should only get easier.

The leading casebook publishers—Thomson/West and its subsidiary, Foundation Press; Aspen Publishers; Lexis-Nexis—undoubtedly make a great deal of money selling statutory supplements.
  Statutory supplements are required in many law school courses.  Statutes and regulations change frequently, so many statute books come out in new editions every year—limiting the resale market that cuts down on casebook profits.

The number of law students and faculty members comfortable with electronic materials is increasing.  Over time, law students will be less willing to pay for expensive, cumbersome print statute books.  As the digital generation continues to enter the law professorate, faculty members will be more willing to provide do-it-yourself digital materials, or to demand that commercial publishers produce them.

Commercial publishers will, probably grudgingly and reluctantly, offer digital statute books.  The attempts so far have been half-hearted.  Thomson West, for example, offers .pdf copies of statutes and rules under the label “Statutes on Demand.”
  But statutes and regulations are available for only two subjects, Corporations and Securities Regulation,
 and access to the digital materials costs almost as much as print statute books.
  Moreover, students must download a DRM plug-in for Adobe Reader and go through a set-up procedure before they may access the files.
  Tellingly, and probably an indication of how reluctant the commercial casebook publishers will be to move to digital books, this product is relegated to a separate web site and is not even mentioned on the main Thomson West site.

It is not surprising that the major commercial casebook publishers have yet to embrace digital statute books.  The advantages that have made them successful in selling casebooks—editorial control, marketing, printing facilities, and distributional ties—are relatively unimportant in selling digital statute books.


Commercial casebook publishers succeed in part because of their editorial reputation.  A professor who chooses a casebook published by Aspen or Thomson West can be reasonably confident that the company has vetted the authors’ expertise, sought editorial review from others in the field, and thoroughly proofread the book.


Editorial expertise is less important for digital statute books.  The content is fairly standard, so little editorial judgment is necessary.  Law professors can easily verify whether the book has the required content.  Proofreading is important, even more important than for casebooks.  But almost all the content is already available publicly in its original form, so little proofreading is required.


Commercial publishers like Thomson West and Lexis-Nexis own or have access to sophisticated printing facilities that allow them to produce thousands of books quickly and at a relatively low cost.  Those physical printing plants may give them an advantage in producing print books, but they are completely unnecessary for digital books.


Commercial casebook publishers also have distributional and marketing edges over potential competitors.  They have existing shipping channels and contacts with University bookstores, where many law students buy their casebooks.  They have networks of sales representatives who regularly contact law professors.  Among other things, those representatives make sure professors have examination copies of all publications the publishers offer for their courses.

All of those advantages are less important in the digital world.  Distributing a digital book is easy.  No bookstores are needed; no shipping is required.  One merely posts the book on a web site and distributes the URL.


That leaves only the marketing advantage.  Competitors producing free or low-cost digital statute books will not have an extensive system of publishers’ representatives or their lists of what each professor teaches.  But it is unclear if that marketing edge really matters as much for digital books.  Anyone producing a new digital statue book could notify professors of its availability by e-mail or through the many subject-area blogs many professors subscribe to.  E-mail is almost costless and the e-mail addresses of professors teaching in selected fields are available for a fee through the Association of American Law Schools.
  Many professors teaching the same subject know each other, so it would not be hard to create a stir by word of mouth.  And examination copies are irrelevant in the world of digital publishing; every professor with the appropriate URL has an instant examination copy.

Once students and faculty become comfortable with digital supplements, the reign of the commercial legal publishers is shaky.  Faced with competition from free or low-cost alternatives, the big commercial publishers will have two options: (1) abandon the market for statutory supplements entirely or (2) offer their own digital statute books at a competitive, substantially reduced price.  The days of charging $45 for publicly available material are numbered.

B.  Maintaining Market Share
The commercial casebook publishers will not cede the market for statutory supplements without a fight.  So what can they do to fight off challenges from free or low-cost digital alternatives?   First, they may continue to control the market for statutory supplements that include copyrighted materials, at least until the copyright holders are willing to license digital statute books.  More importantly, the commercial casebook publishers may keep their control over the statute book market by bundling their statutory supplements with their casebooks.
1.  Supplements Including Copyrighted Material

Legal publishers might also retain a market advantage with respect to statutory supplements that include a substantial amount of copyrighted material.  As previously indicated, some copyright holders are reluctant to license their materials for digital statute books.
  Some statutory supplements include a fair amount of copyrighted materials.
  These supplements are likely to be offered only in print versions until the copyright holders become willing to license digital materials.  

The commercial casebook publishers may retain an advantage with respect to these materials even if the copyright holders agree to license their materials for digital use.  The copyright holders are unlikely to make these materials available for free, even if their use is restricted to law students, in part because the copyright fees the commercial publishers pay are a source of revenue.  The large legal publishers may have economy-of-scale advantages in aggregating these copyright permissions across a number of different supplements and passing that cost on to student users.  If the copyright holders insist on digital rights management, the large commercial publishers may have an advantage in designing and imposing such controls.  Absent significant student and bar pressure on the copyright holders to allow free student use, the existing commercial publishers may be able to retain this portion of the supplement market.

An alternative approach for those wanting to offer free statutory materials to students is to substitute for the copyrighted model and uniform acts the statutes of particular states that are based on those acts.  Digital Business Associations supplements might, for example, include the Model Business Corporation Act as adopted by Nebraska instead of the MBCA itself. However, this workaround is imperfect at best.  States adopting uniform acts usually include non-uniform amendments that would have to be flagged for students.  State numbering of statutes often does not follow the uniform/model act numbering, making it more difficult for students to correlate casebook references to the materials in the statutory supplement.  And professors who teach model and uniform acts often discuss the official comments to those statutes; state statutes would not include the official commentary, and publishing the commentary would present the same copyright issue as publishing the statutes themselves.  Finally, some materials, such as the restatements of the law prepared by the American Law Institute, are not adopted and republished by state legislatures, so state law is not an alternative.  
2.  Bundling Statue Books with Casebooks

Currently, course materials are delivered in one book, the casebook, and the statutory materials are delivered in completely separate book, the statutory supplement.  One statutory supplement, digital or printed, is as good as another for use with the casebook.  If the legal publishers offer an expensive supplement, whether it’s printed or in digital format, and a similar statutory supplement is available for free, students will choose the free product.

However, instead of selling casebooks and statutory supplements separately, the publishers could combine the casebook and the relevant statutes and regulations into a single product—preferably a single digital product.  Students would not need a separate statutory supplement, and the combined product might actually be advantageous to students.  Hyperlinks among the cases, textual explanations, and statutes and regulations would make it easier for students to integrate all of the materials in their studies.
  Whether legal publishers could charge as much for the integrated product as they currently charge for two separate books is unclear, but they might retain at least some of the profit they currently receive from separate supplements, especially since some law professors are notoriously price-insensitive in their choice of casebooks.

VI. Conclusion

We had two goals when we began this project.  One of those goals—to make a free digital securities law statute book available to students—is almost accomplished.  Professor Bradford intends to update the digital securities statute book, use it in his future classes, and make it available to law students and professor nationwide.  For at least one set of classes, the end of the reign of the commercial publishers has begun.  Students now have available for free a better product than those being produced by the commercial casebook publishers.
But we hope what we have done is just a beginning, that we spark a wholesale revolution in the way statutory materials are provided to law students.  To that end, we have tried in this article to provide a roadmap to help other law faculty members do in their fields what we have done in securities regulation.  Our hope is that other professors will follow the path we have blazed or, even better, improve on what we have produced.
  We invite everyone reading this article to join the revolution.

Appendix A
Instructions for Downloading and Formatting Federal Statutes

1. Create a new word file

2. In the word file, insert text like this

Section Title

Regular Text

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

3. Format the text however you would like them to appear in formatted statutes

For example:

Section Title

Regular Text

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

The best way to create the indentations is to select Format > Paragraph from the menu.  Under the section “Indentation,” adjust “Left” to whatever you want.

4. Select Format > Styles and Formatting from the menu.  A sidebar should appear.

5. Highlight “Regular Text” in your document and Click “New Style” in the “Styles and Formatting” sidebar.

6. In the “New Style” window, give the style a name such as “Regular Text” NOTE: It’s important to keep the numbers in the names of the styles for Steps 1-7

7. Repeat steps 5 and 6 by highlighting the other sections and selecting “New Style”

8. Check the Styles and Formatting sidebar to make sure that all of the styles appear and are correct.

9. Go to http://uscode.house.gov/download/ascii.shtml to find whatever statutes you are looking for.

10.  When you have the statutes up, highlight the statutes you want to copy (or Select all on the screen by pressing CTRL + A), and then copy them by pressing CTRL + C

11. Go to your Word file and paste the text into the file by pressing CTRL + V. (you can delete the text you used to set up the styles)

12. Bring up the Find window by press CTRL + F.

13. Click on the “Replace” tab in the “Find and Replace” window.  Also, click “More” at the bottom of the window

14. In the “Find what” text box, type two spaces and a (, or “  (”

15. In the “Replace with” text box, type two periods and a (, or “..(”

16. Click on “Replace all” in the “Find and Replace” window.  Click OK when Word says the replacements have been made.  (Anytime Word says it’s done searching and asks if you want to continue searching, click “Yes”)

17. It’s time to clean up the statutes before we actually format them.

18. Start from the top of the document

19. While scrolling down the document, you will want to do two things:

A.  Delete any sections you do not want to keep.  Likely you are only going to want to keep the Head and Statute sections and delete everything else.  The first section after the Statute is usually “-SOURCE-“ and the end of every statute section has a line that says “-End-”.  This is a helpful guide for highlighting the text you want to delete.  Note: Do not delete the text that says “-HEAD-“, it will be needed later and will be deleted after it has been used.

B.  Look within the Statute sections for sets of periods sticking out.  For example:
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Note how the periods in front of (17) stick out.  Any time you see periods sticking out, check the context to see if the text next to the periods is just part of the paragraph rather the beginning of it.  If it’s just part of the text, delete the two periods and insert two spaces, so it looks like this:

[image: image6.png]& pald LA amount ot such
Shall be stated:

~.118) the amount or estima
detail, of expenses, other
{17) of this schedule, incu
the issuer in connection wi
bffered or properly charges

engineering, certification,

J.118) the net proceeds der
igsusr during the two years

registration statement, the
offered to the puslic, and

of cuch security:





20. Once you are done cleaning the document (that was the time-consuming part), you are ready to format.

21. Bring up the Find and Replace menu (if not already up) by pressing CTRL + F and then clicking the Replace tab in the menu.

22. In the “Find what” text box, type fourteen spaces, then two periods, then (, so it looks like: “              ..(“

23. In the “Replace with” text box, type sixteen periods, then (, so it looks like “…………….(“

24. Click “Replace all” (Word may say that no replacements were made.  This is fine, it just means that there are no “Step 7” sections)

25. In the “Find what” text box, delete two of the spaces.

26. In the “Replace with” text box, delete two of the periods.

27. Click “Replace all”

28. Repeat steps 25-27.  When you have deleted all of the spaces from the “Find what” text box, you are done. 

29. In “Find what” text box, type ^p and then enter fourteen spaces, so it looks like “^p              ”

30. In “Replace with” text box, type one space, so it looks like “ ”

31. Click “Replace all”

32. In the “Find what” text box, delete two spaces.

33. Click “Replace all”

34. Repeat steps 32 and 33.  Only do this until there are four spaces left in the “Find what” text box.  When there are only four spaces left, Click “Replace all”, but do not delete two more spaces after that.  DO NOT click “Replace all” if there are only two spaces left in the “Find what” text box.

35. Select all of you text by pressing CTRL + A.

36. Click on “Regular Text” in the “Style and Formatting” sidebar.

37. Bring up the Find and Replace menu (if not already up) by pressing CTRL + F and then clicking the Replace tab in the menu.

38. In the “Find what” box, type sixteen periods and then (, so it looks like “…………….(”

39. In the “Replace with” box, type just a parenthesis: “(”

40. Click Format at the bottom of the “Find and Replace” window (if you don’t see it, click “More” in the window and it should appear.)  From the menu, select style.

41. Select “Step 7” from the style menu and click O.K.

42. Click “Replace all”

43. Delete two periods in the “Find what” text box (so there are fourteen periods)

44. Click on the “Replace with” text box (don’t change anything in the box)

45. Click “Format” and select “Style”

46. Select “Step 6” from the style menu and click O.K. (after doing this, check the area under the “Replace with” text box, it should say “Style: Step 6”, rather than “Style: Step 7”)

47. Click “Replace all” 

48. Delete two periods in the “Find what” text box (so there are fourteen periods)

49. Click on the “Replace with” text box (don’t change anything in the box)

50. Click “Format” and select “Style”

51. Select “Step 5” from the style menu and click O.K. 

52. Click “Replace all” 

53. Delete two periods in the “Find what” text box (so there are ten periods)

54. Click on the “Replace with” text box (don’t change anything in the box)

55. Click “Format” and select “Style”

56. Select “Step 4” from the style menu and click O.K. 

57. Click “Replace all” 

58. Delete two periods in the “Find what” text box (so there are eight periods)

59. Click on the “Replace with” text box (don’t change anything in the box)

60. Click “Format” and select “Style”

61. Select “Step 3” from the style menu and click O.K. 

62. Click “Replace all” 

63. Delete two periods in the “Find what” text box (so there are six periods)

64. Click on the “Replace with” text box (don’t change anything in the box)

65. Click “Format” and select “Style”

66. Select “Step 2” from the style menu and click O.K. 

67. Click “Replace all” 

68. Delete two periods in the “Find what” text box (so there are four periods)

69. Click on the “Replace with” text box (don’t change anything in the box)

70. Click “Format” and select “Style”

71. Select “Step 1” from the style menu and click O.K. 

72. Click “Replace all” 

73. In “Find what” type -HEAD-

74. Click on the “Replace with” box and make sure it is cleared.  

75. Click the “Format” button in the window and select “Style”

76. Select “Section Title” and click OK

77. Click “Replace all”

78. Click on the “Replace with” box, then click the “No Formatting” button at the bottom of the window.

79. Click “Replace all”

80. In “Find what” type -STATUTE-

81. Click “Replace all”

82. In “Find what” box, type ^p^p^p

83. In “Replace with” box, type ^p^p

84. Click “Replace all”

Appendix B
Instructions for Downloading and Formatting Federal Regulations

1. 
Starting:
1-1. Create a new Word document

1-2. Find the regulations you want to format online.  This tutorial uses the “Electronic Code of Federal Regulations”, available at http://ecfr.gpoaccess.gov/.  This works better than text or .pdf files because every line in such files is considered a paragraph and that makes it harder to format.

1-3. Figure out the hierarchy of the regulations
For example, a regulation may be organized like this:

Rule

(a),(b),(c),…

   (1),(2),(3),…

      (i),(ii),(iii),….

         (A),(B),(C),….

             and so on….

1-4. Once you’ve figured out how the regulations are organized, create a sample regulation in your Word file and format it however you want it to look.  Include some sort of formatting for regular text.  This is necessary so you have some sort of default format for “unformatted” text.  

In this tutorial the formatting will look like this (but you can format it however):

§ 230.133   Regulation Title

Regular Text:

(a) Step 1

(1) Step 2

(i) Step 3

(A) Step 4
and so on... 

2.
Using Styles.  Once you have the formatting how you want it, it’s time to set up styles so you can more easily apply the formatting.  After doing this, you might want to save that file as a blank document so you can just use that file as a template for multiple documents

2-1. From the Menu, select Format > Styles and Formatting.   A sidebar “Styles and Formatting will appear on the right side of the window.  (In Word 2007, styles can be found in the “Home” tab.  In the “Styles” bar, click the little [image: image7.png]


 button in the lower right corner.

2-2. Highlight “Regular Text” (or whatever your default text is) in your document  

2-3. In the “Styles and Formatting” sidebar, click on the “New Style” button

2-4. In the “New Style” window, In the “Properties” section, type in a name for the style under “Name”.

2-5. The “New Style” window will allow you to change the formatting further if you want, press “OK” when you are done making any changes.

2-6. Highlight another section in your document, such as the regulation name.

2-7. In the “Styles and Formatting” sidebar, click on the “New Style” button

2-8. Type in a name for the style. (In this tutorial, “regulation name” is used for the name, “Step 1 (a)” is used for the first tier, “Step 2 (1)” is used for the second tier, and so on…)

2-9. Click on the box by “Style based on:” and select “Regular Text” (or whatever name you gave your default text).  Note: This step is not necessary, but it will make it easier in the future to make general changes to the formatting of all of the text, regardless of its style.

2-10. Make any other changes to the style as desired.

2-11. Press “OK”

2-12. Repeat steps 2-6 through 2-11 for every other section type you have.

2-13. Check the “Styles and Formatting” sidebar to make sure all of your new styles are on the list.

3.
Starting on the Regulations.  Now that you are done setting up the styles, it’s time to format the document.

3-1. Clear your Word document so it’s blank.

3-2. On the regulations website, highlight and select the regulations you want to copy to your document.

3-3. Press CTRL + C, or right click over the text and select “Copy”

3-4. Go to your word document, and paste the regulations by Pressing CTRL + V, or selecting Edit > Paste from the menu.

3-5. Select all of the text by pressing CTRL + A, or selecting Edit > Select All from the menu.

3-6. Press CTRL + Shift + F9

3-7. In the “Styles and Formatting” sidebar, select "Clear All"

4.
Cleaning up the Regulations.  Before we get to the main formatting, first we need to clear out some unnecessary items, like the “top” link and graphic at the top of each regulation.

4-1. Press CTRL + F, or select Edit > Find in the menu.

4-2. Click “More” at the bottom of the “Find” window

4-3. Click the “Replace” tab near the top of the menu

4-4. Click on the text box for “Find what:” and type ^gtop (the ^ symbol is SHIFT + 6)

4-5. Leave the “Replace with” text box empty.

4-6. Click Replace All.  If Word says it is finished searching and asks you to continue searching from the top, click “Yes”.  When Word says the replacements have been made, click “OK”  (If this doesn’t work, try typing ^g top, if this doesn’t work, then you will have to remove the top link manually)

4-7. In the “Find what box” type ....§
4-8. Click on the “Replace with” text box.

4-9. Click on the “Format” button at the bottom of the window and select “Style”

4-10. Select “Regulation Title” (or whatever title you used) and press OK.  The “Replace with” box should be empty, but underneath it should say Format: Style: Regulation Title.

4-11. Click “Replace All”. Click “Yes” and “OK” if necessary.

4-12. Click on the “Replace with:” text box and then click “No Formatting” at the bottom of the window.

4-13. In the “Find what box” type  ^p
4-14. Click on “Format” at the bottom of the window and select styles.

4-15. Select “Regulation Title” (or whatever you used) and press OK.

4-16. Click on the “Replace All” button.  Click “Yes” and “OK” if necessary.  You have deleted the space between the title and the regulation.  The regulation title will have returned to its original format, but that will be fixed later.

5.
Formatting

5-1 First, we’ll set up the Regulation Titles.  

5-2 In “Find what:” text box, type ^p§ (to place the section symbol in the box, you can copy it from the document.  Highlight a § from the document and press CTRL+C, and then paste it in the “Find what:” box by pressing CTRL+V)

5-3 Type ^p....§ in the “Replace with” box.  (Note: the “. . . .” is used so that only section marks at the beginning of a paragraph can be found later on, rather than all section marks.  The four periods will be used later on for other sections for the same reason)

5-4 Click “Replace All”.  Click “Yes” and “OK”

5-5 In the “Find what” box, type ....§
5-6 Click on the “Replace with” text box.  Click “Yes” and “OK” if necessary.

5-7 Click on the “Format” button at the bottom of the window and select “Style”

5-8 Select “Regulation Title” (or whatever title you used) and press OK.  The “Replace with” box should be empty, but underneath it should say Format: Style: Regulation Title.

5-9 Click “Replace All”. Click “Yes” and “OK” if necessary.

5-10 Clear out the “Find what:” and “Replace with” text boxes, including selecting “No Formatting” for both.

5-11 In “Find what:” text box, type ^p(
5-12 Type ^p....( in the “Replace with” box.

5-13 Click “Replace All”.  Click “Yes” and “OK”

Formatting (a),(b),(c),… (lower case letters)

5-14 Clear out the “Find what:” and “Replace with” text boxes, including clicking “No Formatting” button for both if necessary.

5-15 In “Find what:” text box, type ....(a)
5-16 Under “Search Options”, click so there’s a check mark by “Match case”.

5-17 Click on the “Replace with” text box, and then click the Format button in the window, select Style

5-18 In the Replace Style window, select “Step 1 (a)” (or whatever you called it)  Note: This tutorial assumes a hierarchy of (a),(1),(i),(A), which should apply to most regulations.  If (a) is not the first tier for the regulation you are formatting, use whatever style that is appropriate for (a).  The order you do things in is not important so long as you are using the appropriate style for each type of text.

5-19 Click “Replace All” and press “Yes” and “OK” if necessary

5-20 In “Find what:” text box, change ....(a) to ....(b)
5-21 Click “Replace All” and press “Yes” and “OK” if necessary

5-22 Repeat steps 5-17 and 5-18 for the remaining letters, EXCEPT (i):

5-23 SPECIAL RULE FOR (i):  Because (i) is also used as a Roman Numeral in the regulations, (i) requires some special formatting:

5-24 After formatting lines with (h), leave ....(h) in the “Find what:” text box.

5-25 Click the “Find Next” box.  The document will show the (h) highlighted.

5-26 Scroll down until you find an (i) that is meant to be a letter rather than a number.

5-27 Delete the four periods before the (i).  (This way, you won’t change it later when you deal with the Roman numeral (i) later on)

5-28 Highlight the entire paragraph for the (i)

5-29 In the “Styles and Formatting” sidebar, select “Step 1 (a)” or whatever style you are using for lowercase letters.

5-30 Repeat 5-22 through 5-25 until all of the (i)’s have been formatted

5-31 After finishing the (i)’s, repeat Steps 5-17 and 5-18 for (j),(k),(l),… (you can stop when Word tells you that you have made 0 replacements)

Formatting (1),(2),(3)…

5-32 In “Find what:” text box, type ....(^#) (the ^# stands for any number, so will take care of all numbers at once)
5-33 Click “Replace with:” text box, then click on Format and select Style.

5-34 Select “Step 2 (1)” or whatever style is appropriate and press OK.

5-35 Click “Replace All” 

5-36 In “Find what:” text box, change ....(^#) to ....(^#^#)
5-37 Click “Replace All” and “Yes” and “OK” if necessary.  (This may do nothing, but will take care of any double digit numbers like (10) or (11) if there are any in the regulations)

Formatting (i),(ii),(iii)

5-38 In “Find what:” text box, type ....(i)
5-39 Click “Replace with:” text box, then click on Format and select Style.

5-40 Select “Step 3 (i)” or whatever style is appropriate and press OK.

5-41 Click “Replace All” and “Yes” and “OK” if necessary.

5-42 Repeat steps 5-35 through 5-38, replacing (i) in the “Find what:” text box with (ii), (iii), and so on…

Formatting (A),(B),(C)

5-43 In “Find what:” text box, type ....(A)
5-44 Click “Replace with:” text box, then click on Format and select Style.

5-45 Select “Step 4 (A)” or whatever style is appropriate and press OK.

5-46 Make sure that there is a check mark next to “Match case” under “Search Options”

5-47 Click “Replace All” and “Yes” and “OK” if necessary.

5-48 Repeat steps 5-40 through 5-44, replacing (A) in the “Find what:” text box with (B), (C), and so on…

Formatting other things/Formatting in general

5-49 In “Find what:” text box, type ....(?), replacing the question mark with whatever you want to format.

5-50 Click on the “Replace with:” text box.  Don’t type anything in it.

5-51 Click on Format button and select Style

5-52 Select whatever style you want to apply to the text you want to format, and Click OK

5-53 Make sure that there is a check mark next to “Match case” under “Search options”

5-54 Click “Replace All”

5-55 If asked to continue search, click Yes.

5-56 Click OK.

6.
Finishing Formatting

6-1 In the “Find what:” text box, type ...., and also click “No Formatting” if necessary

6-2 Clear out the “Replace with:” text box, and also click “No Formatting” if necessary.

6-3 Click “Replace All”.

Appendix C
Student Survey
Professor Bradford

Spring 2009

Survey Concerning Digital Statute Book

Compilation


As you know, this was the first time I used the digital statute book, Securities Law: Statutes and Regulations, in my classes.  I will use it again next year, and will also make it available to students nationwide.  To help me improve it, I would appreciate it if you could answer the following questions.  Please provide as much detail as possible.

Thank you for your willingness to participate in this survey.  You may e-mail the completed survey to me at sbradford1@unl.edu or print it and either drop it off at my office or put it in my mailbox in the Dean’s Office.

1.  Which of the following categories best describes your use of the digital securities statutes book?

A. I used only the printed statute book.

B. I used only the digital statute book.

C. I used both the digital statute book and the printed statute book.

D. I used neither the digital statute book nor the printed statute book.

Answer: 

	A
	B
	C
	D
	Total

	
	20
	4
	
	24


2.  If your answer to Question 1 was A, please describe why you chose not to use the digital statute book.

COMPLETE THE REMAINDER OF THE QUESTIONS ONLY IF YOU USED THE DIGITAL STATUTE BOOK AT LEAST PART OF THE TIME.

3.  If your answer to Question 1 was C, approximately what percentage of the time did you use the digital statute book (0-100%): _______. 
 50% x2

20% x2

4.  If your answer to Question 1 was C, please explain why you chose to use both the digital statute book and a printed statute book.

I chose to use the printed statute book because it was easier to refer to it if I was working on another document on my laptop.  I used the digital statute book primarily for copying and pasting specific sections into my notes.  I also used the digital statute book if I was reading the text without taking notes on my laptop.  In short, I found both to be helpful given the situation at the time

I like to have hard copies of things to look at, but when we go back and forth between provisions of the statute, it’s easier to look at the book for one and the computer for the other.  The highlight feature was also handy

I prefer to use printed versions when studying. I feel that pick up the material better in that format, and I am able to view the statutes and write my outline at the same time in a much more effective manner than by using split screens on the computer. However, I also liked the fact that the digital was easier to “carry around” and thus easier on my back

I used the statute book because I prefer reading things in print.

5.  Did you have any technical problems opening or using the digital statute book?  If so, please explain.

Only downloading the program; I have a MacBook Pro and my computer wouldn’t read the program because I didn’t have the necessary Adobe software installed on my computer.

No, I did not have any technical problems opening or using the digital statute book

None

Yes, I couldn’t use the Table of Contents feature on the MAC version of a PDF reader.  Once I downloaded the newest version of Adobe & then re-downloaded the Statute book, it was fine.

When opening the digital statute book, my laptop seemed to run slower than normal for over a minute or so; however, once it was completely open I didn’t experience any further problems.

Because the digital statute book is such a large file, it often caused my computer to run slowly.  This often forced me to “Force Quit” many other programs that I was attempting to run at the same time.  I could usually run both Microsoft Word and the Digital Statute Book at the same time.  However, whenver I tried to run both my digital statute book and the Internet at the same time, my internet often functioned much slower than usual
For these reasons, I am very concerned about how my computer will handle the digital textbook during the final exam.

It usually took a few minutes to open

I had no problems with the statute book. I used a program called Foxit Reader as I downloaded it to help make edits in my statute book for tax and the program worked great.

No [7 students gave this answer and nothing more for this question]

Yes, the highlight function did not work until I updated to the most recent version of Adobe Reader.\

No.  I downloaded the file and used Mac ‘Preview’ as a reader with no technical issues at all

I did not have any problems opening the file. In fact, it was nice to have the DSB on the website so I didn’t have to have my computer with me every time I was studying. All I had to do was know the website and I could open it from anywhere.

I had no technical problems

No, I found the digital statute book very easy to use

I never had any problem opening the statute book

6.  Did you have any difficulty reading or navigating within the digital statue book?  If so, please explain.

No [8 students gave this answer and nothing more for this question]

In general, it took some time to become familiar with navigating within the digital statute book.

I found it at times was cumbersome to switch between sections. For example if I was reading in the Securities Act and then wanted to look at the corresponding rules, it was difficult to go back and forth. Especially if the section was one that was very long. Scrolling through 5 or 6 pages to get to the precise subsection was difficult. Having the collapsible table to jump between sections was very helpful. It would be even more helpful if it added one more lawyer to include subsections. The ability to create your own bookmarks would be helpful. I think some versions of adobe let you, but the version I had did not.

I also had trouble knowing where in the statute I was. I could click on the section in the table pane on the left, and that would take me to the beginning of whatever section or rule I had selected, but I ran into trouble when I began scrolling down. I would lose track of the subsections. If I were looking for (a)(36), I sometimes did not know if I had not scrolled down far enough or if I went too far. It can be difficult to follow the subsections with their indentations. Another example of this is when you have a 3(b)(2)(A), and the next section has either a 3(C)(2)(A). If you scroll past the 3(c) part by accident, on some sections, you won't know that you are reading the wrong subsection until it is too late.

None

Some of the paragraph structures were off for a couple of the statutes, making them a little more difficult to read.  Otherwise no.  It might be good to have a running header for the statutes that go on forever.  Sometimes it was hard to tell where you were at in the statute on the really long ones

I did not have any difficulty navigating through the digital statute book

The only difficulty I had was that, again, because the digital statute book is such a large file, it often took a while for my digital statute book to load and/or to process my commands.  This was problematic during class, at times, because the file wasn’t fast enough to keep up with the pace of your questions during class

It took me a few minutes to figure out the whole layout of the book, but once I got it figured out, it was relatively easy to navigate

I found it difficult to navigate the statute book in class.  If there is a way to bookmark the regs, I am not tech savvy enough to have figured it out.  I basically had difficulty going from one statute to the other.  I still have not figured out how to do this quickly.

Not much difficulty at all.  Only one minor reading difficulty: Lack of indentions or other means to differentiate separate code annotations (sometimes if a statute was subdivided into A, B, and C, it was harder at a glance to get a feel for all parts of the statute or follow previous language from above.

I had no problem navigating in the statute book because it was bookmarked very extensively. I did however have some problem reading some of the sections. The formatting seemed to be off a little. For example: in the Investment Company Act Section 2(a)(3) definition of Affiliated Person there are further subsections A-F, but the subsection D is formatted farther to the left than the provision 2(a)(3) itself. I would find myself thinking that this was a whole other provision and not a continuation of 2a3. There were a few other examples of this in the statute book but I cannot quite remember where they are.

Sometimes it was hard for me to find a statute or rule because it would begin at the bottom of the page and was thus cut off on my screen.  I would click the section number using the bookmarks navigation and then would not see the section because it would below my where the page was cut off due to my screen and the default page size.  This was less of a problem once I was used to using the document

This may or may not be an issue for everyone, but I was annoyed by how slow it takes to scroll down and find a subsection within a particular section if that section is particularly long.   Because of the size of the file, it’s impossible to just use the mouse to try to manually move the scroll bar a tad to get to the subsection you want.  Perhaps there isn’t a solution other than using additional bookmarks or taking out portions of the Acts that we don’t cover to reduce its size

No, using the bookmarks within Acrobat was very easy

No – the bookmarks are a life saver

The only difficulty was using the bookmarks. At times it was difficult to see which set of statutes you were in and collapsing that list to access another set of statues.

I never had any difficulty navigating within the digital statue book.

7.  Did you have any difficulty highlighting or annotating the digital statute book?  If so, please explain.

No [12 students gave this answer and nothing more for this question]

Adobe reader tended to be somewhat difficult to use. I will list a couple of examples. If I selected a section of text that I wanted to highlight, I would do so, then right click and select highlight. Often it would take two or more attempts before I could get the exact section I intended to be highlighted. The auto select would sometimes include more or less text then I desired. A second problem I had is if I already had some text highlighted but I wanted to highlight or underline text nearby, the auto select would include the text already highlighted and complicate the process. I began trying to use the annotating features of boxes with arrows, and boxes without arrows. If I tried doing this during class, it would take too long and I would miss want was discussed next. It took too long to get it just right and make it useful. I wish you could just point and click and type in a faster method. I would try and make a text box and the adobe reader was often delayed in its response to my clicks of the mouse. It became frustrating, so I stopped using the annotating features, although I still used the highlighting features.

It was somewhat difficult to underline a word that had already been highlighted. The text box would appear unless you put the pointer in the exact location to underline.

I didn’t try it.  I typed my comments in my notes

I did not experience any problems

I did not attempt to highlight or annotate in the digital statute book.  I take all of my notes in a separate Microsoft Word document

I did have some problems highlighting. I have to admit I didn’t quite figure it out the first time you explained it in class so I only highlighted that one day. Every time I opened the saved copy of the DSB I had on my computer, after I highlighted that one time, it would then open with the bookmarks open that I had the one time I highlighted it. This was not a big concern at all to me though. If I would have figured out how to highlight correctly I am sure this would not have happened.

Not really

I tried early on to highlight and annotate, but I ended up being overwhelmed by the number of things to highlight and annotate and by the lack of any real system on my part for it all to make sense or be organized.  I know a bit about using Adobe, but not much past the basics.  Future classes could probably benefit from a half day demonstration of the most useful features of Adobe early on in the semester

No, but I don’t really annotate, so I never tried that.

No.  I appreciated having the ability to take notes directly in the statute during class.

I was unable to highlight or annotate because I have the older version of adobe.

8.  Did you prefer the digital statute book to printed statute books you have used in other classes?

Typically I like using printed statute books because it is easier for me to highlight and markup.  However, I liked using the digital statute book for this class because of the control find key as it was taking too much time navigating my way through the printed statute version the first week of class.

For the purposes of classroom discussion, I preferred using the printed statute book. It is easier to flip between sections, write exactly what you want in the margins, with highlighting and arrows. Further, having multiple screens (class notes, reading notes, and statute book) can make things more complicated, although I think most students would adapt. If adobe reader were more user friendly, I think I would always use the digital statute book

Yes, however for exam purposes it may be difficult to switch from one window to the next continuously. I’m not sure if the exam4 window can be resized to a smaller one.

Yes [8 students gave this answer and nothing more for this question]
Yes.  The only other one I’ve used was for the Federal Tax Code

I think the printed statute books I’ve used in other classes are easier to use because the table of contents more clearly laid out where I could find specific material, and I didn’t have to worry about the time it took my computer to load the program and then process my commands

Yes!!  I much preferred it.  It was so much easier to use than flipping through a book.

Definitely

I am more comfortable with “hard copy,” but the price of the digital statute book was right.

Yes, quite a bit.

Yes, very much. It is easier to navigate and quicker to search. I also liked the price, free

Yes for a few reasons: 
1.  Free 

  2.  Easily maneuverable (clicking rather than flipping)

  3.  Easily transportable/no bulky book to lug

  4.  I can cut and paste to another document with ease

  5.  I can’t even read my handwriting sometimes—so typed comment boxes on the statute itself is handy.

  6.  I can print out the specific portions we talked about, with my highlighting instead of carrying in a 1000-page statute book to an exam.

Digital statute books have great promise and with someone who knows how to use all the features of adobe to make note taking organized and make sense, it would be tremendously advantageous over printed statute books.  For me however, it was probably a wash.  The ability to use Control F to find a particular word or the bookmarks to find a particular Act, Section, or Rule quickly though is great.

No, not necessarily

I use the two for separate reasons, so they are probably equally nice to have.

I did prefer the digital statute book. With it I had less to carry and it was easier to navigate & make notations in

I preferred the statute book because I could underline and annotate. If I had the newer version of abode I may have stayed with the digital version.

9.  What aspects of the digital statute book did you find most appealing?

Control find as well as the table of contents

I enjoyed not having to purchase a book. It made copying text from the statute book to my notes quicker and easier

The ability to highlight, underline and add text was extremely beneficial. I was able to modify the statute as we were discussing it and could cut and paste the definitions of words right onto the word itself using the text box.

The table of contents- rather than having to flip through pages to find the right statute section

The ability to cut & paste specific sections as well as the ability to make notes/highlight/etc.

I appreciate that you made it available to us free of cost.
I also enjoy having it available electronically because the “Find” function on my computer (Control F) allows me to search for specific words. That is usually how I found a specific rule.

The price was right!  It was relatively easy to navigate, much quicker than a book, it wasn’t a “used” version like I would normally get stuck with if I bought the book, so I didn’t have to deal with someone else’s comments and highlighting.  I also liked that I could make quick notes on the text.

The ability to quickly navigate from one section to another was the most appealing part to me. And the fact that it was free

Not having to carry around a huge statute book all day

It is nice not to have to carry around a large statute book

The ability to navigate directly to a particular section from the toolbar; the ability to highlight and annotate it.

1.  Quick reference/navigation 

2.  Didn’t have to carry around a physical book 

3.  Improved pace of class lectures 

The price and navigation were really the best parts of using the DSB. 

See answer to question 8 [reprinted below]

Yes for a few reasons: 
1.  Free 

  2.  Easily maneuverable (clicking rather than flipping)

  3.  Easily transportable/no bulky book to lug

  4.  I can cut and paste to another document with ease

  5.  I can’t even read my handwriting sometimes—so typed comment boxes on the statute itself is handy.

  6.  I can print out the specific portions we talked about, with my highlighting instead of carrying in a 1000-page statute book to an exam.

I liked not having to carry (or buy) a statute book.  I also liked that it was relatively quick to get to a statute or rule and that it was easier to use for outlining because I could have it up on my screen next to my outline document.

Everything.  Highlighting, Easy access to information, and note taking function

See above [Digital statute books have great promise and with someone who knows how to use all the features of adobe to make note taking organized and make sense, it would be tremendously advantageous over printed statute books.  For me however, it was probably a wash.  The ability to use Control F to find a particular word or the bookmarks to find a particular Act, Section, or Rule quickly though is great.]

The bookmarks made it easy to go to the exact subsection of any statute we were talking about. It was much better than thumbing through pages

The highlight feature

First, that I didn’t have to drag another massive tome around from one class to another.

Second, since I’m already taking class notes on computer, it’s easier to stay focused on the screen instead of switching back and forth between screen and hardcopy.

Third, the digital version is easier and simpler to edit. All my notes are readable, the underlining straight and uniform, the highlighting doesn’t bleed through. Makes later review much simpler. 

Fourth, the digital version is easier to navigate. The bookmarks feature means no more frantic flipping through pages.

Finally, it’s better for the environment. We’ve been reading about the paperless revolution for years, it’s time it arrived.

It was convenient, since I didn’t have to haul a big statute book with me to class.  I also liked being able to search within the statutes

It was more convenient
Ease of note taking.

It was easier to move through the sections.

10.  What aspects of the digital statute book did you find least appealing?

I was happy with the digital statute book.

The least appealing part of the digital statute book was trying to jump between sections. In particular, trying to go from subsection to a new section and subsection was difficult.

Nothing really except for when a section (i.e., definition section for ICA) had numerous subsections.

Nothing- once I figured out how to get the table of contents working ( (before that- trying to find the right section)

Overall, I did not find any aspect that was not appealing.  I think that any limitation is due to the constraints of my laptop – both processing speed as well as screen size

The amount of material was daunting, and it also made my computer run slowly

It would have been nice to have been able to identify certain sections (like definitions) for quick reference.  Sometimes it got cumbersome having to scroll all the way up or down the bookmarks while I was trying to keep up in class.  I really wanted to be able to do something quick, like Edit-Find a code section easily.

Can’t make notes w/in the statute like a book. The sticky notes were ok, but it’s a whole lot easier just to write your notes in the corresponding section

Bookmarking the statutes we focused on.

No complaints

1.
When combined with digital text, made screen space tight.  (But still manageable)

2.
Lack of indentions or other means to differentiate separate code annotations (sometimes if a statute was subdivided into A, B, and C, it was harder at a glance to get a feel for all parts of the statute or follow previous language from above.

In class it took longer to flip from one section to another. In other classes when I had a hard copy of a statute book I would tag the pages to certain provisions I used a lot and I was not able to do this with the digital copy.

The only thing I wish I could do would be to cut/delete portions, not being used for the final.  The bookmarks help, but there are just portions of the statute we didn’t cover and I’d like the ability to reduce any sort of time looking for stuff as much as possible.  I’d want to be able to create a “final version (short)” and keep the full version for future reference

It is sometimes harder for me to carefully read through dense text when it is on a computer screen, but the ability to annotate made that easier.

It was great.  No complaints

See above [Digital statute books have great promise and with someone who knows how to use all the features of adobe to make note taking organized and make sense, it would be tremendously advantageous over printed statute books.  For me however, it was probably a wash.  The ability to use Control F to find a particular word or the bookmarks to find a particular Act, Section, or Rule quickly though is great.]

Reading the statutes on a computer can get a little hard on the eyes

I don’t know if there’s a “Search” function, but if there isn’t, one of those would be nice

Only that you have to have your computer out and open to use it. No quick references if the computer isn’t already on

Sometimes it took my computer awhile to open the statute file, since it’s so large.  I was behind a few times in class because I would accidentally close the file or my computer would freeze, but that’s most likely a problem with my computer rather than the file

I don’t learn/digest information very well off of a computer screen

Just navigating the bookmarks

11.  If you had to choose again between using the digital statute book and a printed statute book, would you make the same choice?

Yes [12 students gave this answer and nothing more for this question]
I would first try and get a cheap copy of the statute book, then I would go to the digital statute book. Lastly I would buy a new copy if it was my last resort.

I would likely make the same choice; however, I should also note that I received my printed statute book for free so if I had to pay full price for the printed version, I may only go with the digital statute book

Probably yes, because the digital statute book is free.  However, if I have technical difficulties with the digital statute book while taking the final exam, that will change my opinion in a hurry

Yes, I would definitely take the digital book

Yes, I would prefer to have a digital statute book in all classes compared to a hard copy.

I would use the digital version again.

I’d still go digital, but try to spend time early on figuring out a system for note taking and sticking to it.

Yes, I’d use both again

Yes. For most law students, school revolves around their laptop. It makes sense to put more stuff like statutes in digital form

Yes, I would use both of them again

Yes.  I am normally prefer having hard copies but I liked this digital statute book since we could mark it up. It was especially helpful in a course that focuses on statutes

I would have used the printed throughout the semester but that may because I don’t have the newer version of abode.

12.  What suggestions do you have to improve the digital statute book?

Making it “Mac-friendly” for the purpose of downloading.

Perhaps in the bookmark tab include subsections for sections with more than ____

Perhaps, as suggested above, a header when a statute spill over onto multiple pages.  It was hard to tell sometimes what subsection of what subsection of the statute section you were in if it was a really long one.

No suggestions

Try to shorten it a bit by taking out some material that likely isn’t necessary.

Nothing other than 10 above.

If there is any way to add hyper links in the text of some of the sections it would make it even more convenient. Like in the language of 5b which talks about conforming to the requirements of section 10—you could be able to click on the text section 10 and go right there. It is a small thing, but it would be a nice feature.

I wish there was some sort of way to tab within the index the important parts of the statute (like you saw when we turned in our Bus Associations statute books).  Without that ability, it makes it important to have a proper flowchart

Review it for typographical errors.  I saw a few

None

My only suggestion has to do with the formatting errors it had with the subsections. This made it hard to read the provisions sometimes. It is the problem I described above.

See answer to question 10, but I’m sure there was probably a reason the security settings were set so as to prevent modification—to prevent accidental deletions/statements on finals that “my statute book doesn’t have §5 of the Securities Act so it doesn’t exist?”

I believe Adobe allows internal hyperlinks, so it would be really helpful to have a linked complete table of contents at the very beginning of the document.  I think that would allow for faster navigation than the bookmark navigation.  

None

See above [Digital statute books have great promise and with someone who knows how to use all the features of adobe to make note taking organized and make sense, it would be tremendously advantageous over printed statute books.  For me however, it was probably a wash.  The ability to use Control F to find a particular word or the bookmarks to find a particular Act, Section, or Rule quickly though is great.  I’d still go digital, but try to spend time early on figuring out a system for note taking and sticking to it.]

None

The “search” function; other than that, I thought it was good

Is it possible to divide the book into two or three files?  That would be helpful for those of us whose computers are slower

13.  Please provide any additional comments here.

During the Securities Brokers exam, I knew what statutes to go to, and I had already highlighted them. So this eliminated scrolling past them and ending up somewhere else. I knew all the quirks already, so using it on the exam worked well for me

I liked that you didn’t have to lug around a big statute book.  And the cost was reasonable (
No additional comments

I appreciate that efforts you made to put together the digital statute book, and that you offered it to your students free of charge.

Great option for students and practicing lawyers.  I would definitely use it in the future

I thought the digital statute book was the way to go, and I think future students would be very grateful for this option.

It was great.  Thank you

I appreciate the effort to try something new and different.  PDFs offer a number of advantages over printed materials, not the least of which is cost.  

Might note that there’s a freeware pdf application called Foxit Reader that has all the functionality but less bloat than Adobe Reader. I’ve had zero problems with it. It also opens much faster than Abobe does.

Again, I thought the digital statute book was great overall. I usually prefer having hard copies but the ability to interact with the digital book made it easy to get your comments down while looking at the statute.  Thanks for letting us use it!

Should recommend to future students that if they have the older version of adobe (i.e., cannot annotate or highlight) to use the printed statute book.
Appendix D
Post-Exam Follow-Up

Professor Bradford

Spring 2009

Supplemental Survey—Use of Digital Statute Books on Exam
Compilation
My Question:

I hope everyone did well on the exam.  If you have any comments, positive or negative, about using the digital statute book to take the exam, please let me know.

Thanks.

Steve Bradford
_____

Compiled Responses:

Wanted to let you know that I did not use the digital statute book for the exam.  Due to my laptop's small screen, I found it easier to use the print version.  However, I will say that I found it to be very helpful throughout the year.  If I were forced to choose between the two, I would choose the digital version.

_____

I am pleased to report that using the digital statute book at the same time as Exam 4 did not create any problems for me as I took your test.  The digital statute book often slows my computer down, so I was worried about how it might function on the exam.  Thankfully, your digital statute book performed well when I needed it the most.  Thanks again for taking the time and energy to provide the digital statute book to your students, free of charge.  Enjoy your summer.

_____

Sorry I didn't get this to you sooner--guess I've had exams on the brain lately!  In general, I really appreciated the statute book.  My only complaint was that it was a little difficult to search using the bookmarks.  Being able to do a code section "find" (type in the code section you're looking for) would have made things a bit easier than scrolling through all of the code sections, then through all of the subsection to get to the right one.

_____

I thought the statute book was a great help during the exam. It enabled for quick reference to the statutes. As I raved about in my survey, having the notes/highlighting in the digital was quite helpful.

_____

I found the digital statute book easier to use on the final than a hardcopy statute book.  I think the bookmark navigation helped me access specific sections faster ... at least faster than tabs would have.  So, I would recommend it for use on exams.

_____

It was great.  Really easy to use.

To change the indentation to give it an outline look, select the text you want to indent.


Then click Format>Paragraph


In the “Paragraph” window, there is an “Indentation” section.  Change the “Left” setting to whatever you want.  In the example to the left, Step 2 is indented .2”, Step 3 is indented .4”, and Step 4 is indented .6” 








� Earl Dunlap Distinguished Professor of Law, University of Nebraska College of Law.  This research was funded in part by a Ross McCollum Summer Research Grant.  I have presented some of the ideas in this article at two programs: (1) Materials for the Classroom: The Usual Suspects and New Ideas, AALS Section of Teaching Methods, AALS Annual Meeting, Washington, D.C., January 4, 2007; and (2) The Future of Casebooks: Can Anyone Deliver What I Want?, CALI Annual Conference on Law School Computing, Las Vegas, Nevada, June 18, 2007.  My thanks to the participants at those conferences for their helpful comments and questions.  My thanks also to my co-author and former research assistant, Mark Hautzinger, and to my current research assistant, Tyler Bartruff, for their helpful assistance.


� J.D. 2009, University of Nebraska College of Law.


� Although these books often contain regulations, forms, and various other materials in addition to statutes, they are commonly called statutory supplements or statute books.


� For instance, the Coffee and Sales casebook Securities Regulation (11th ed. 2009) has a list price of $138.00.  See   � HYPERLINK "http://www.westacademic.com/Professors/ProductDetails.aspx?productid=149196&tab=1" �http://www.westacademic.com/Professors/ProductDetails.aspx?productid=149196&tab=1� (last visited May 12, 2009).  The statutory supplement prepared by Tom Hazen for the same course has a list price of $45.00. See � HYPERLINK "http://www.westacademic.com/Professors/ProductDetails.aspx?productid=145052&tab=1" �http://www.westacademic.com/Professors/ProductDetails.aspx?productid=145052&tab=1� (last visited May 11, 2009).  


� Assuming a price of $40 a book, a student would exceed $500 if he or she took thirteen courses requiring such supplements.  That does not seem like an extraordinary number over three years of law school.


� Even that proposition is questionable.  See, e.g., Matthew T. Bodie, The Future of the Casebook: An Argument for an Open-Source Approach, 57 J. Legal Educ. 10 (2007); Robert Laurence, Casebooks are Toast, 26 Seattle U. L. Rev. 1 (2002).


� Twenty of 24 students who responded to a survey used the digital statute book exclusively; the other four used both the digital statute book and a printed book.  The print alternative was Thomas Lee Hazen, ed., SECURITIES REGULATION: SELECTED STATUTES, RULES AND FORMS: 2009 EDITION (2009).  Its list price is $45.  See � HYPERLINK "http://www.westacademic.com/Professors/ProductDetails.aspx?productid=145052&tab=1" �http://www.westacademic.com/Professors/ProductDetails.aspx?productid=145052&tab=1� (last visited May 11, 2009).  An abridged version is available for a list price of $33, but it does not include all of the materials needed for one of the two classes.  See � HYPERLINK "http://www.westacademic.com/Professors/ProductDetails.aspx?productid=149396&tab=1" �http://www.westacademic.com/Professors/ProductDetails.aspx?productid=149396&tab=1� (last visited May 11, 2009).


� See � HYPERLINK "http://www.aals.org/about.php" �http://www.aals.org/about.php�. 


� Since law publishers don’t share cost data with the public, the exact production cost savings is uncertain.  However, existing undergraduate digital books cost approximately fifty percent of the retail price of their hard-copy equivalents.  Advisory Committee on Student Financial Assistance, TURN THE PAGE: MAKING COLLEGE TEXTBOOKS MORE AFFORDABLE 21 (May 2007) (available at � HYPERLINK "http://www.ed.gov/about/bdscomm/list/acsfa/turnthepage.pdf" ��http://www.ed.gov/about/bdscomm/list/acsfa/turnthepage.pdf�).


� Thomas Lee Hazen, ed., SECURITIES REGULATION: SELECTED STATUTES, RULES AND FORMS: 2009 EDITION.


� Melvin Aron Eisenberg, ed., CORPORATIONS AND OTHER BUSINESS ORGANIZATIONS: STATUTES, RULES, MATERIALS, AND FORMS: 2008 EDITION.


� Matthew Bodie, The Future of the Casebook: An Argument for an Open-Source Approach, 57 J. Legal Educ. 10, 14 (2007).


� Except for the unfortunate ones whose professors have prohibited the use of laptops in class.  See, e.g., Kevin Yamamoto, Banning Laptops in the Classroom: Is It Worth the Hassles?, 57 J. LEGAL EDUC. 477, 483 (2007); Eric Finkelstein, No Logoff in Fight Over Laptops in Class: Law Students, Professors Debate Classroom Bans, National Law Journal, June 26, 2006, at 6, col. 2.


� Bodie, supra note 6, at 10.


� See Thomas Lee Hazen, ed., SECURITIES REGULATION: SELECTED STATUTES, RULES, AND FORMS III (Abridged ed. 2008).


� See John C. Coffee, Jr., et al, eds., FEDERAL SECURITIES LAWS: SELECTED STATUTES, RULES AND FORMS: 2007 EDITION iii (2007).


� See, e.g., Melvin Aron Eisenberg, ed., CORPORATIONS AND OTHER BUSINESS ORGANIZATIONS: STATUTES, RULES, MATERIALS, AND FORMS: 2008 EDITION (2008).


� It’s not just students.  Professor Bradford has had this happen on trips, or when he is working from home.


� Printed statutory supplements often have multiple tables of contents—a basic one at the front that a page reference for each distinct set of materials, and a more detailed table of contents within each set of materials.  See, e.g., Melvin Aron Eisenberg, ed. CORPORATIONS AND OTHER BUSINESS ORGANIZATIONS: STATUTES, RULES, MATERIALS, AND FORMS: 2008 EDITION v-vii, 1-6.


� See generally Debra Moss Curtis & Judith R. Karp, In a Case, On the Screen, Do They Remember What They’ve Seen?  Critical Electronic Reading in the Law Classroom, 30 HAMLINE L. REV. 247, 249-261 (2007) (discussing the differences between reading on screen and reading in a book).


� See Cory Doctorow, You Do Like Reading Off A Computer Screen (March 2007) available at � HYPERLINK "http://www.locusmag.com/Features/2007/03/cory-doctorow-you-do-like-reading-off.html" ��http://www.locusmag.com/Features/2007/03/cory-doctorow-you-do-like-reading-off.html� (Last viewed August 4, 2008).  Even this complaint is overstated.  Professor Bradford has read books on his 15-inch laptop screen and 24-inch LCD monitor, and he now regularly reads all law review articles on his computer.


� For example, Amazon recently produced a new version of its Kindle e-book reader in a larger format directed specifically to the textbook market.  See “Amazon Introduces Big-Screen Kindle,” NEW YORK TIMES (May 6, 2009).  And there are rumors that Apple is developing a touch-screen reader that would essentially be a larger version of their iPod Touch.  See “Large-Screen Kindle Won’t Mean Squat if Apple Tablet Arrives,” � HYPERLINK "http://www.wired.com/gadgetlab/2009/05/kindle-vs-apple/" �http://www.wired.com/gadgetlab/2009/05/kindle-vs-apple/� (last visited May 4, 2009).


� Cory Doctorow, You Do Like Reading Off A Computer Screen (March 2007) available at � HYPERLINK "http://www.locusmag.com/Features/2007/03/cory-doctorow-you-do-like-reading-off.html" ��http://www.locusmag.com/Features/2007/03/cory-doctorow-you-do-like-reading-off.html� (Last viewed August 4, 2008).


� See http://www.law.cornell.edu/ (Last visited July 30, 2008).


� In addition, the LII claims a copyright on its formatting and organization of the materials available on its web site, and we wanted to avoid any copyright restrictions.


� See http://uscode.house.gov/lawrevisioncounsel.shtm (Last visited July 30, 2008).  Files may be downloaded as ASCII text files or as .pdf files.  See http://uscode.house.gov/download/download.shtml (Last visited July 30, 2008).


� See http://uscode.house.gov/about/info.shtml (Last visited July 30, 2008).  See also 2 U.S.C. 285b(3) (Office of Law Revision Counsel responsible to “prepare and publish periodically a new edition of the United States Code”)


� See http://uscode.house.gov/about/info.shtml (Last visited July 30, 2008).


� See � HYPERLINK "http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl" ��http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl� (last visited July 22, 2008).


� Id.


� Id.


� Id.  The Administrative Committee of the Federal Register (ACFR) has statutory authority over the Code of Federal Regulations.  See 44 U.S.C. § 1510(c).  Once the remaining issues are resolved, the Government Printing Office and the Office of the Federal Register will propose to the ACFR that the e-CFR become an official edition of the CFR.  See � HYPERLINK "http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl" ��http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl� (last visited July 22, 2008).


� See � HYPERLINK "http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl" ��http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?sid=40014c700a8903f5594c817482ebcccd&c=ecfr&tpl=%2Findex.tpl� (last visited July 22, 2008).


� The site says simply that “[t]here are no plans to make the e-CFR available in PDF format while the site is in beta status.”  Id.


� See American Association of Law Libraries, State-by-State Report on Authentication of Online Legal Resources Appendix A (March 2007), available at � HYPERLINK "http://aallnet.org/aallwash/authen_rprt/AuthenFinalReport.pdf" ��http://aallnet.org/aallwash/authen_rprt/AuthenFinalReport.pdf� (Last viewed August 5, 2008).


� Id., at 37.  A few states have made the online repository the official publication, and no longer publish print versions of some or all of the state statutory or regulatory materials.  See id., at 35.


� Id., at 74.


� California, for example, excludes the building standards title, which includes copyrighted materials from model code providers.  Id., at 86.  As of March 2007, much of the Colorado administrative code was still “under construction.”  Id., at 88.  The coverage in Vermont is “uneven and incomplete.”  Id., at 182.


� See, id., at 90 (Connecticut); 92 (Delaware); 130-131 (Mississippi); 144 (New Jersey); 148 (New York).


� See http://washlaw.edu/ (Last viewed August 5, 2008).


� See http://www.abanet.org/cpr/mrpc/mrpc_toc.html (Last visited July 30, 2008).


� The Model Business Corporation Act, as revised through 2002, is available on-line.  See www.abanet.org/buslaw/library/onlinepublications/mbca2002.pdf (Last visited July 30, 2008).  However, the Act has been amended several times since 2002, and the most recent version is not publicly available.


� See http://www.law.upenn.edu/bll/archives/ulc/ulc_final.htm#final (Last visited July 30, 2008).  This archive contains not only final acts approved by NCCUSL, but also drafts of other statutes.  See  http://www.law.upenn.edu/bll/archives/ulc/ulc.htm#drafts (Last visited July 30, 2008).


� See http://www.law.upenn.edu/bll/archives/ulc/ulc_final.htm#final (Last visited July 30, 2008).


� See Bodie, supra note 6, at 30-31.


� An alternative would be to use the text of the act as adopted by a particular state, particularly if that state uses a numbering system that matches the section numbers of the model act.


� They were willing to consider licensing the statute for use in a particular course at a particular law school, but not for materials that would be available to all law students nationwide.


� We were less concerned about accessibility issues related to the production of the materials.  Law professors can assign and use the materials without knowing how to create them.


� In spite of some law professors’ continuing fascination with WordPerfect, the rest of the world has passed it by.  Most lawyers and most law students (and most law professors, for that matter) use Word, and, although Word is not a free product, many universities have site licenses that allow students to purchase a full-featured copy of the Word software for a nominal price.  At the University of Nebraska-Lincoln, for example, students may buy Microsoft Office 2007 Professional suite for only $14.99.  See http://shop.unl.edu/software.php [last visited July 29, 2008].  In any event, we have found that Word documents can easily be read by WordPerfect, so putting statutory materials into Word’s .doc format would not freeze out WordPerfect users.


� The person creating a .pdf document in Adobe Acrobat does this quite easily by clicking on the Comments menu, then clicking on “Enable for Commenting and Analysis in Adobe Reader.”  Anyone reading the document in Acrobat Reader may then activate a Commenting toolbar that allows one to highlight, underline, and add comments, among other things.  


� Pub. L. No. 105-304, 112 Stat. 2860 (Oct. 28, 1998).


� For example, the Thomson West Interactive Casebook series is accessed via a password-protected web site.  See � HYPERLINK "http://www.interactivecasebook.com" �http://www.interactivecasebook.com�.  StatutesOnDemand, Thomson West’s limited experiment with digital statutes, offers downloadable documents in .pdf format, but those files are protected by digital rights management.  See � HYPERLINK "http://statutesondemand.com/Default.aspx" �http://statutesondemand.com/Default.aspx�.  StatutesOnDemand uses an add-on to Adobe Reader; the files cannot be accessed without that add-on, which limits transferability.  See � HYPERLINK "http://statutesondemand.com/faq.aspx" �http://statutesondemand.com/faq.aspx�. 


� See, e.g., David I. C. Thomson, LAW SCHOOL 2.0: LEGAL EDUCATION FOR A DIGITAL AGE 87-88 (2009).


� See, e.g., Cory Doctorow, Giving It Away (Dec. 1, 2006), available at http://www.forbes.com/2006/11/30/cory-doctorow-copyright-tech-media_cz_cd_books06_1201doctorow.html [Last visited July 29, 2008].


� Most of our time and effort was spent figuring out what we wanted to do and how to do it.  That is a nonrecurring cost.


� The Uniform Securities Act is available on-line.  See � HYPERLINK "http://www.law.upenn.edu/bll/archives/ulc/securities/2002final.htm" �http://www.law.upenn.edu/bll/archives/ulc/securities/2002final.htm�.  In the future, to facilitate further student exploration of the Uniform Act, we may include in the digital securities book a hyperlink to the Uniform Act.


� (5th ed. 2006).


� In class, Professor Bradford used the statute book in digital form, but used printed copies of the course materials.  He decided that it would be too hectic to keep track of both the digital statutes and the digital course materials on his relatively small laptop while simultaneously running PowerPoint slides off the classroom computer.  Younger faculty members who grew up multitasking on a computer might be able to do this more easily.


� As discussed in section V.C.3, infra, a couple of students complained that the digital statute book slowed down their computers significantly.  In the future, we might create separate statute books to reduce the size of the file, at least in the Securities Regulation course, and, we hope, alleviate this problem.


� See � HYPERLINK "http://uscode.house.gov/lawrevisioncounsel.shtml" �http://uscode.house.gov/lawrevisioncounsel.shtml�. 


� See � HYPERLINK "http://ecfr.gpoaccess.gov/" �http://ecfr.gpoaccess.gov/�. 


� See � HYPERLINK "http://www.sec.gov/" �http://www.sec.gov/�.  Some of the SEC forms are already available in .pdf format, so no reformatting was required.


� We decided to make the materials available in .pdf format, but even Adobe recommends that one edit documents using word processing software before converting those documents to .pdf.


� The “we” in this sentence and the next was Mr. Hautzinger.  Professor Bradford initially did reformat the Securities Act of 1933 line by line, but, when he realized the amount of time required, he asked Mr. Hautzinger to develop a more efficient method.


� For example, we found 33 final rules releases from the SEC in the period May 1, 2008-April 30, 2009.


� In the Adobe Acrobat file menu, select Combine, then Merge Files Into a Single PDF.


� Go to � HYPERLINK "http://www.unl.edu/bradford/Securities%20Regulation.htm" �http://www.unl.edu/bradford/Securities%20Regulation.htm� and click on the “Digital Statute Book” link.


� The alternative was Thomas Hazen, ed., SECURITIES REGULATION: SELECTED STATUTES, RULES AND FORMS: 2009 EDITION.


� See Appendix C, Questions 1,3, infra.  As far as we know, none of the students who used the digital statute book printed it in its entirety.  It is does appear, however, that some students printed individual sections of the statutes or rules for particular classes.  See Appendix C, infra.


� Not surprisingly, several students indicated that cost was an important advantage of the digital statute book.  See section V.A, infra.


� Professor Bradford chose his current car rather than a Porsche 911 GT2 primarily because of the cost of the Porsche.  He is reasonably sure the Porsche would be better, but his less expensive car performs adequately.


� Eighteen students were enrolled in Securities Regulation and eleven students were enrolled in Securities Brokers, but a few students were enrolled in both classes, so the total number of students was only 25.


� A few of the full surveys were returned after the exams, which explains why the full survey includes comments about using the digital statute book on the exam.


� See Appendix C, Question 1, infra.


� See Appendix C, Question 9, infra. The four remaining students either expressed no clear preference or indicated that they preferred print for some purposes and digital for others.  Id.


� See Appendix C, Question 11, infra.


� See Appendix C, Question 9, infra.


� See Appendix C, Question 10, infra.


� See Appendix C, Question 10, infra.


� In addition to the version on his laptop, Professor Bradford installed a copy of the digital statute book on the classroom computer, but he never used that digital backup, either.


� It was much easier to create those slides using the digital statute book.  Professor Bradford merely cut the relevant material from the digital statute book and pasted it into the appropriate slide.


� On the other hand, one cannot easily remove or edit highlighting or annotation on a printed book, something that is easy to do in the .pdf version.  And, on a digital copy, one never has the problem of insufficient space in the margins in which to fit annotations.


� When using a print statute book, Professor Bradford often provides page numbers so students can locate a particular section more quickly.  That speeds up the use of the print book, so it is not clear that using the digital book materially changed the total class time spent navigating within the materials.


� A few of the students’ navigation problems involved fairly basic problems using their computers.  For example, one student complained that it was “impossible to just use the mouse to try to manually move the scroll bar a tad to get the subsection you want,” apparently not realizing that clicking on the arrow key on the scroll bar adjusts the page view a line at a time.  We just assumed that students would already be adept at things like this.


� See � HYPERLINK "http://pdf-tips-tricks.blogspot.com/2007/11/how-to-add-bookmark-capability-in.html" �http://pdf-tips-tricks.blogspot.com/2007/11/how-to-add-bookmark-capability-in.html� (last viewed May 11, 2009). 


� An unmarked version of the digital statute book is 17.8 MB.  My copy with all of my annotations and highlighting is 20.0 MB.


� We could have made the corrections on the .pdf itself and distributed a new version of the digital statute book.  However, students who had already highlighted and annotated the statute could not have easily transferred their mark-up to the new version.


� See � HYPERLINK "http://www.exam4.com" �http://www.exam4.com�. 


� See Appendix D, infra.


� The Title Page includes the following instructions:





1. Table of Contents





a. To access the table of contents, click on the Bookmarks tab in Adobe


Reader. (If the Bookmarks tab is not visible, choose Navigation Tabs in the Adobe


Reader View menu, then select Bookmarks.)





b. To make navigation easier, I suggest you keep the Bookmarks frame


open as you use the materials. You can change the relative sizes of the bookmarks


and text panes by clicking your mouse on the line between them and moving the


division line to the desired location.





c. You can move to any location in the materials by clicking on it in the


Bookmarks tab.





2. Highlighting and Comments: You can highlight or add comments to these


materials. In the Adobe Reader Tools menu, choose Commenting, then click on


Show Commenting Toolbar. You can highlight, underline, or add notes or


comments to the text. Just remember to save the revisions when you exit the


materials.


� We are not sure why this student did not simply download the newest version of Adobe Reader, unless he or she did not realize it is available for free.  


� One of the students suggested Foxit Reader, another .pdf application.  Professor Bradford has used Foxit, and it is a little trimmer and less clunky than Adobe Reader, so we may suggest it to students in the future as an alternative to the Adobe product.


� Professor Bradford went through this briefly in class when one of the students indicated she had trouble highlighting, but this instruction should be included in the digital book itself.


�Professor Bradford would be happy to advise any law professor who wishes to do something similar in another subject area.


� The exact amount is unclear, but a couple of publishers' representatives have told Professor Bradford privately that statutory supplements are quite profitable.


� See � HYPERLINK "http://statutesondemand.com/Default.aspx" �http://statutesondemand.com/Default.aspx�.


� Id.


� The full set of Corporations materials costs $43.00; the full set of Securities Regulation materials costs $36.00.  See � HYPERLINK "http://statutesondemand.com/Professors.aspx" �http://statutesondemand.com/Professors.aspx�.  A professor may create a customized set of materials at a lower price.  Id.  However, a barebones set of materials for a basic securities course—the Securities Act; Securities Act rules; the Exchange Act; Exchange Act rules; and forms under both statutes—would exceed the limit for the reduced pricing.  Id. 


� See � HYPERLINK "http://statutesondemand.com/faq.aspx" �http://statutesondemand.com/faq.aspx�.


� StatutesOnDemand does not appear on the Thomson West home page for professors, and is not accessible via either the “Technology Tools” or “Product Lines” links on that page.  See � HYPERLINK "http://www.westacademic.com/professors/default.aspx" �http://www.westacademic.com/professors/default.aspx�.  It also is not listed in either the Corporations or Securities Regulation sections of the web site under “Statutes and Court Rules.”  See � HYPERLINK "http://www.westacademic.com/Professors/ProductSearchResults.aspx?searchtypeasstring=BROWSE-BY-ANY&subject=33&tab=5" �http://www.westacademic.com/Professors/ProductSearchResults.aspx?searchtypeasstring=BROWSE-BY-ANY&subject=33&tab=5�; � HYPERLINK "http://www.westacademic.com/Professors/ProductSearchResults.aspx?searchtypeasstring=BROWSE-BY-ANY&subject=133&tab=5" �http://www.westacademic.com/Professors/ProductSearchResults.aspx?searchtypeasstring=BROWSE-BY-ANY&subject=133&tab=5�.  The Thomson West home page offers a search tool, but a search for StatutesOnDemand produced nothing.





� With a few hours’ work, anyone with a copy of the latest AALS directory could create their own list without paying the fee.


� See section III.A.4, supra.


� The supplements used for Business Associations and Corporations courses are a good example.  They typically include the Model Business Corporation Act; at least one version each of the Uniform Partnership Act, the Uniform Limited Partnership Act, the Uniform Limited Liability Company Act; at least one version of the Restatement of Agency; and often the American Law Institute Principles of Corporate Governance.  All of these materials are copyrighted: the MBCA by the American Bar Association; the Uniform Acts by the National Conference of Commissioners on Uniform State Laws; and the Principles of Corporate Governance by the American Law Institute.


� The Aspen Study Desk is a move in this direction.  Aspen has not yet incorporated statutes into the Study Desk mix, but at least one Aspen representative has indicated an interest in doing so.


It is less clear that the combined casebook/statutory supplement is good pedagogically.  One of the skills that law students learn in regulatory classes is how to work their way through statutes and regulations.  A text that automatically provided them with the relevant statutes and regulations would not necessarily force them to develop those skills.  Of course, as the statutes and regulations themselves become increasingly accessible in digital form, it's not clear that the "statute-searching" skill will be all that important in the future.


� We have no special technological or marketing genius, and we are sure that professors with more technological expertise can improve on our simple efforts.  





